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NOTICE

1. The information contained herein can change without notice owing to product and/or
technical improvements. Before using the product, please make sure that the
information being referred to is up-to-date.

2. The outline of action and examples for application circuits described herein have been
chosen as an explanation for the standard action and performance of the product.
When planning to use the product, please ensure that the external conditions are
reflected in the actual circuit and assembly designs.

3. When developing and evaluating your product, please use our product  below the
specified maximum ratings and within the specified operating ranges including, but not
limited to, operating voltage, power dissipation, and operating temperature.

4. OKI assumes no responsibility or liability whatsoever for any failure or unusual or
unexpected operation resulting from misuse, neglect, improper installation, repair,
alteration or accident, improper handling, or unusual  physical or electrical
stress including, but not limited to, exposure to parameters beyond the specified
maximum ratings or operation outside the specified operating range.

5. Neither indemnity against nor license of a third party's industrial and intellectual
property right, etc. is granted by us in connection with the use of product and/or the
information and drawings contained herein. No responsibility is assumed by us for any
infringement of a third party's right which may result from the use thereof.

6. The products listed in this document are intended only for use in development and
evaluation of control programs for equipment and systems. These products are not
authorized for other use (as an embedded device and a peripheral device).

7. Certain products in this document may need government approval before they can be
exported to particular countries. The purchaser assumes the responsibility of
determining the legality of export of these products and will take appropriate and
necessary steps at their own expense for these.

8. No part of the contents contained herein may be reprinted or reproduced without our
prior permission.

9. MS-DOS, Microsoft, Windows and WindowsNT are registered trademarks of Microsoft
Corporation. Other product names and company names are trademarks of registered
trademarks of their respective owners.

Copyright 1999 Oki Electric Industry Co., Ltd.
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1 . Introduction

1.1  About the Products

The DT63K debugger and DTS63K simulator are software development support
tools for evaluating and debugging embedded user application programs created
with the Oki SASM63K structured assembler for the Oki OLMS-63K series of 4-
bit CMOS microcontrollers. The DT63K debugger requires an in-circuit emulator;
the DTS63K simulator emulates the target device entirely in software. The user
interface and debugging facilities available are otherwise identical. The developer
is therefore able to freely switch between the two within the same project in
accordance with current needs.

1.1.1  Common User Interface
The DT63K debugger and DTS63K simulator share a common user interface
providing rapid, interactive access to all the features offered by these advanced
debugging environments.

� Windows 95 or Windows NT operating environment
These tools are 32-bit applications providing a rich, flexible debugging
environment.

� Multiwindow interface
You can freely modify the layout of all windows on the screen by changing their
sizes and positions. Multidocument interface (MDI) support also means that you
can have multiple windows of the same type open at the same time.

� Extensive on-screen help
Help consists of the quick on-screen help, simple introductory comments that
appear on the status line when a menu item is selected, and the far more
comprehensive on-line help.

� Source level and symbolic debugging
The DT63K debugger and DTS63K simulator provide source level debugging
functions that permit debugging while viewing the SASM63K structured assembler
source code. You can also display and use the symbols used for labels and

DT63K
DTS63K

DT63K
DTS63K
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segments in assembly language programs developed with this package.

� Macro functions
Macro support provides automated operation using text files written in a scripting
language. These macro functions relieve you of the tedium of procedures that have
to be repeated, purely mechanical operation over extended periods, and other forms
of batch processing.

1.1.2  DT63K Debugger Features
The DT63K debugger, in conjunction with an Oki Electric in-circuit emulator,
supports evaluation and debugging of microcontroller embedded application
software in a hardware environment approaching that of the finished application.

� Real-time emulation
This mode provides full-speed execution that is closest to the final application
environment.

� Single-step execution
This mode executes program code one instruction at a time. When you wish to
trace program execution in detail, use single-step execution and examine the
contents of peripheral registers (SFR), registers, and data memory locations after
each instruction.

� Cycle counter
If your system demands real-time response, you frequently wish to know precisely
how long certain sequences take to execute. The in-circuit emulator can help by
counting execution cycles during emulation execution.

1.1.3  DTS63K Simulator Features
The DTS63K simulator offers LCD panel simulation, I/O port simulation, and
other simulation capabilities not available with the DT63K debugger.

� LCD Panel Simulation
The software simulates an LCD panel on the development host screen using data
file from the LCDTOOL utility.

� Timer and Port Simulation
The software’s simulation capabilities extend to the operation of time base and
other counters and of I/O ports.

DT63K

DTS63K
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� Melody and Buzzer Simulation
The software’s simulation capabilities extend to the operation of melody and
buzzer drivers.

� Close Compatibility with DT63K
A user interface largely identical to that of the DT63K debugger allows the
developer to freely switch between the two within the same project.

1.2  Structure of This Manual

This manual consists of the following chapters.

� Chapter 1 Introduction
This Chapter.

� Chapter 2 Before You Start
This Chapter gives the system requirements for the products, their place in the
development process, and the installation procedure.

� Chapter 3 Loading, Preparation, and Projects
This Chapter discusses loading the products, preparing to execute programs, and
the structure of project files.

� Chapter 4 Program Execution
This Chapter discusses program execution and closely related functions.

� Chapter 5 Break Functions
This Chapter describes the various break conditions available for breaking program
execution.

� Chapter 6 Displaying/Modifying Memory and Registers
This Chapter describes the procedures for viewing the contents of memory
locations, the program counter, and other registers and then modifying those
contents.

� Chapter 7 Watch Windows
This Chapter describes the procedures for specifying watch items—memory
locations, registers, and other objects—for monitoring in a Watch window.

DT63K
DTS63K
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� Chapter 8 Tracing
This Chapter describes the use of the tracing capabilities built into the products.

� Chapter 9 Cycle Counter
This Chapter describes the use of the cycle counter built into the products.

� Chapter 10 Source Level Debugging
This Chapter describes the procedures for source level debugging with Source
windows.

� Chapter 11 Symbolic Debugging and Input Formats
The products allow the use of expressions in place of numerical values. Especially
important here is the description of the procedures for writing expressions
incorporating the symbols used in symbolic debugging.

� Chapter 12 Other Functions
This Chapter covers macros, logging, on-line help, and other miscellaneous
functions.

� Chapter 13 DTS63K Simulation Functions
This Chapter describes the simulation of peripheral functions by the DTS63K
simulator.

� Chapter 14 LCDTOOL Utility
This Chapter describes the use and functions of the LCDTOOL utility.

� Chapter 15 Appendices
This Chapter provides detailed listings of menus (both main and local), tool bars,
shortcut keys, etc. for the DT63K debugger, DTS63K simulator, and LCDTOOL
utility.

� Index
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1.3  Notational Conventions

A key is represented by the legend on the key. If keys must be pressed together,
they are joined with a plus sign (+). The notation [Shift]+[F1] in the text, for
example, means that you are to hold down a [Shift] key and press the [F1] key.

This Manual uses the following icons in the left margin to indicate the scope of the
accompanying material.

Material applicable to both the DT63K debugger and DTS63K
simulator

Material applicable to the DT63K debugger only

Material applicable to the DTS63K simulator only

Material applicable to the LCDTOOL utility only

This Manual does not use any other icons or other notational conventions that need
explaining.

This Manual also uses the numeric formats, units, and notations shown in the
Table.

Classification Notation Meaning

Numbers xxh, xxH Hexadecimal notation, where xx
denotes a sequence of hexadecimal
digits.

Word 1 word = 16 bits

Byte 1 byte = 2 nibbles = 8 bits

Nibble 1 nibble = 4 bits

kilo or K 210=1024

DT63K
DTS63K
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2 . Before You Start

2.1  System Configuration

The DT63K debugger and DTS63K simulator share the following operating
environment requirements.

� Development Languages Supported
SASM63K structured assembler Version 2.21 or later

� Operating Environment
• Operating System Windows 95, Windows NT 4.0 and later
• Hardware Environment sufficient to run the above

operating system reliably and efficiently
• Display Graphics adapter and display device with a

minimum resolution of 640×480 (VGA)
• Hard disk space At least 10 megabytes free
• 3.5-inch floppy disk drive
• Mouse

� DT63K Debugger Environment Requirements
The DT63K debugger has the following additional requirements.

• Serial port

• Compatible in-circuit emulator (A list of supported models appears as a
separate document.)

� Checking DT63K Debugger Hardware Environment
Before you can even load the DT63K debugger, you must first connect and
configure the development host, in-circuit emulator, and user application circuit.
Items to be checked include the following.

• Power supply to the in-circuit emulator

• Clock operating frequencies

DT63K
DTS63K
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• Target device settings

• User cable joining in-circuit emulator to user application circuit

• Probe cable connections

Note that the above is a minimal list. For further requirements, refer to the manual
included with the in-circuit emulator.
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2.2  Using Products in Development Process

The products read program code files in two basic formats: the Intel HEX format
and the Oki Electric source level debugging (.dbg) format.

The Intel HEX format is a general-purpose ASCII format widely supported by
third-party PROM writers. Note, however, that this format has an address space of
only 64 kilobytes.

The Oki Electric source level debugging (.dbg) format is Oki Electric’s own binary
format, which the SASM63K structured assembler uses when producing Oki
Electric source level debugging (.dbg) format program code files containing source
line information.

� Intel HEX Half-Word (.hxh and .hxl) Files
Because the OLMS-63K series uses 16-bit instructions, this format uses two Intel
HEX format program code files: a .hxh file for the higher 8 bits and a .hxl file for
the lower.

Oki has extended the format specifications to allow users to include user symbol
information in program code files in this format. Because these extensions are in
compliance with Intel HEX format specifications, third-party utilities and PROM
writers should simply ignore the symbol information in such files.

DT63K
DTS63K

DT63K
DTS63K
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� External Data (.h00–.hff) Files
The SASM63K structured assembler uses the Intel HEX format for addresses in the
external data memory space, but uses numbered extensions to give the bank
number in hexadecimal. (Note that each bank contains 64 kilobytes.)

� Oki Electric Source Level Debugging (.dbg) Files
The SASM63K structured assembler uses the extension .dbg for files containing
debugging information.

Before you can view a source file or debug in a DT63K/DTS63K Source window,
you must first load this type of file.

� LCD Data (.LCD) Files
DTS63K simulator capabilities include LCD panel simulation using common and
segment specifications from these files. To prepare them, create the desired
displays as Windows bit-mapped files (.BMP)—with MS Paint, for example—and
convert them with the LCDTOOL utility.

DT63K
DTS63K
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2.3  Installing DT63K and DTS63K

The DT63K debugger and DTS63K simulator use standard Windows installation
procedures.

� Installing the Software
1. Insert setup disk #1 in the floppy disk drive.

2. Run the setup utility (SETUP.EXE).

3. Follow the instructions that appear on the screen.

� Uninstalling the Software
• Open the Control Panels folder.

• Double-click the appropriate icon to uninstall the software.

� Backing Up the Software
We strongly recommend that you make backup copies of all installation disks and
store the originals in a safe place.

DT63K
DTS63K
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3 . Loading, Preparation, and Projects

3.1  Loading the Software

� Start Menu
The setup utility automatically creates a program group under Programs on the
Start menu.

Double-click the corresponding icon to load either the DT63K debugger or the
DTS63K simulator.

Normally, the software automatically loads the last project used in the preceding
session. The first time, however, there will be no such project.

� DT63K Debugger
The DT63K debugger starts with the following dialog box and waits for a reset
code from the in-circuit emulator.

Clicking the left mouse button on the Cancel button immediately closes the
software.

Clicking the left mouse button on the Settings button displays the following dialog
box specifying the serial link speed (bps) and the port.

Note that the speeds available depend on the hardware and other factors. Members
of the NEC PC-9801 and PC-9821 series, for example, only support speeds up to
38,400 bps.

DT63K
DTS63K

DT63K
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Clicking the left mouse button on the Cancel button immediately closes the dialog
box, canceling any changes.

� DTS63K Simulator
The DTS63K simulator starts with the following dialog box.

Clicking the left mouse button on the Start button loads the software configured for
the specified target device.

Clicking the left mouse button on the Cancel button immediately closes the
software.

Clicking the left mouse button on the Target... button displays a dialog box for
specifying a new target device.

DTS63K
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3.2  Preparing for Debugging

3.2.1  Environment Settings
Open the Tools menu and choose the Environment settings menu command.

� Project
Click this tab to display the project configuration panel.

� Directories
Click this tab to display the default directories for the various file types.

3.3  Preparing for Emulation

3.3.1  Specifying Target Device
The DT63K debugger determines which device-specific field to read from the
target device setting in the in-circuit emulator. To view this setting, open the View
menu and choose the Status menu command to open a Status window. If this
setting does not match the target device, switch the in-circuit emulator to SETICE
mode using the procedure in the in-circuit emulator manual, reload the DT63K
debugger, and change the setting with the File menu’s Load TCD file menu
command.

3.3.2  Specifying Emulator Options
The DT63K Tools menu’s Options menu command displays a dialog box
controlling in-circuit emulator options.

DT63K
DTS63K
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� Code Memory Expansion
These radio buttons control the use of the in-circuit emulator’s function for
expanding code memory to 64K words. The default is to limit code memory size to
that of the program memory for the target device.

� Timer/Counter Controls
These check boxes control the use of time base counter (TBC) and watchdog timer
(WDT) signals during emulation and single-step execution. The default is to enable
these signals. Selecting a check box disables the corresponding signal.

� User Reset Pin
Selecting this check box disables the user cable’s RESET pin input during real-time
emulation.
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3.4  Preparing for Simulation

3.4.1  Loading LCD Data File
LCD panel simulation with the DTS63K simulator requires an LCD data file
created from Windows bit-mapped files with the LCDTOOL utility. (See Chapter
14 “LCDTOOL Utility.”)

Load this file with the File menu’s Load LCD data file menu command.

3.4.2  Assigning Ports
I/O port simulation with the DTS63K simulator requires assigning port inputs to
keys on the development host’s keyboard.

� Displaying Port Assignments
Clicking the left mouse button on the Port button at the bottom of the Port window
displays the current port-key assignments by port number.

Port Name: Port name

Key: Key assigned to port as push button or on/off switch

Status: Current port status (0: “Low” level; 1: “High” level)

Type: Port type (INPUT or OUTPUT)

Mode: Port configuration

Pull-up:  Input with pull-up resistor

Pull-down:  Input with pull-down resistor

Pull-up/down:  Input with pull-up/down resistor

DTS63K

DTS63K



3. Loading, Preparation, and Projects

16

Highinp:  High-impedance input or output

CMOS: CMOS output

NchOD:  n-channel open drain output

PchOD:  p-channel open drain output

Connection: Port connection

No assignment:  Unassigned

Button (VDDI):  “High” level push button

Button (GND):  “Low” level push button

Switch (VDDI):  “High” level on/off switch

Switch (GND):  “Low” level on/off switch

Connected (V DDI): Always “High” level

Connected (GND):  Always “Low” level

Connected Pxx:  Connected to specified output port

Pull up:  Pull-up connection

Pull down:  Pull-down connection

Key matrix:  Key matrix connection

� Displaying Key Matrix
Clicking the left mouse button on the Matrix button at the bottom of the Port
window displays the current key matrix table.
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� Displaying Key Assignments
Clicking the left mouse button on the Keymap button at the bottom of the Port
window displays the current port-key assignments by key name.

� Simple Key-Port Assignments
There are three ways to display the dialog box for assigning port inputs to keys on
the development host’s keyboard.

y Click the left mouse button on the Port button, right-click, and choose the
Change key assignments... menu command from the context menu.

y Click the left mouse button on the Keymap button, right-click, and choose the
Change key assignments... menu command from the context menu.

y Choose the Tools menu’s Change key assignments... menu command.

All three methods lead to the same dialog box.
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Input Port: Port to assign to key

Output Port: Connection to output port (Only valid for Connected to other port
radio button)

Key: Key to assign

Connection: Input port connection

Apply button: Saves assignment without closing dialog box

� Setting Up a Key Matrix
The above one-to-one approach is insufficient for a user application program
requiring numerous input keys. A key matrix then becomes more efficient.

Key matrix designs generally expand the number of input gates available by using a
rectangular grid connecting input ports along the y-axis to output ports along the x-
axis. The circles in the figure indicate the positions of push buttons or on/off
switches.

To simulate such a key matrix with the DTS63K simulator, press the Matrix button
at the bottom of the Port window. If there is no key matrix defined, the window
displays the following empty key matrix.

X1

P4.0

X2

P4.1

X3

P4.2

X4

P4.3

Y1 P0.0

Y2 P0.1

Y3 P0.2

Y4 P0.3

Output Port

Input Port
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To add a port to the matrix, right-click on the appropriate New button and select
the menu’s Add menu command to add a row or column to the grid.

When the grid is complete, assign keys by selecting an intersection and hitting the
[Enter] key to display the following dialog box.

Button: Simulate push button

Switch: Simulate on/off switch

3.4.3  Specifying Simulator Options
The DTS63K Tools menu’s Options menu command displays a dialog box
controlling simulator options.

DTS63K
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� High-Speed Clock
If the user application program uses the high-speed clock, specify the frequency
here.

� LCD Refresh Period Setting
Sets the refresh period for the LCD window during simulation. The LCD window
refresh period can be set to a value in the range 55 to 550 ms.

� Wait
• “Wait setting” check box

Check this check box to have a wait inserted every time the specified number
of instructions are executed. This function allows the program execution time
to be made close to that of the actual microprocessor execution time.

� Code Memory Expansion
These radio buttons control the use of the function for expanding code memory to
64K words. The default is to limit code memory size to that of the program
memory for the target device.

� Melody Output
Selecting this check box enables melody output.

� External Data Memory
Selecting this check box enables the use of external data memory.
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� LCD Settings
• Set pixel off color to the background color check box

Sets whether or not LCD pixels that are turned off are displayed in the same
color as the background color.

When this check box is checked, the simulated image will match the image
actually displayed.

• Perform LCD graphics overlap processing check box

Sets whether or not bitmap graphics are displayed faithfully during simulation.
Since LCD graphics display becomes somewhat slower when this check box is
checked, clear this check box if higher speed LCD graphics is desired.
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3.5  Loading/Saving Program Code

3.5.1  Loading Program Code
The DT63K debugger and DTS63K simulator accept program code created with
the SASM63K structured assembler.

The File menu’s Load program file... menu command displays a dialog box for
specifying the program file to debug or simulate.

� Loading Debugging Information Too
Selecting “Debug file (*.dbg)” as the file type loads the specified debugging
information file and the corresponding program code (.hxh and .hxl) files.

Note that loading this file automatically clears all current debugging information
(source line information and symbol table).

� Loading Only Program Code
Selecting “Program code (*.hxh)” as the file type and double-clicking a file from
the list or selecting “All files (*.*)” and double-clicking a file with the
extension .hxh or .hxl loads both members of the program code file pair.

Note that loading these files does not clear the current debugging information.

� Clearing Breakpoints
Because loading a new program normally renders current breakpoints useless, it is

DT63K
DTS63K
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usually a good idea to select the Clear all breakpoints check box.

� Limiting the Range
One situation where you might not want to clear breakpoints is when reloading
only a ROM data table or a subroutine using the address range specification list
boxes at the bottom of the dialog box.

3.5.2  Saving Program Code
The File menu’s Save program file... menu command displays a dialog box for
specifying the destination for saving a program file with adjusted parameters in the
ROM table or modified program.

� Saving Program Code Only
Specifying a file with the extension .hxh or .hxl saves the program code to the
corresponding program code file pair.

� Saving Symbol Table
To save the symbol table with the program code, select the Save symbols check
box.

� Limiting the Range
To save only the program code within a specific address range—a ROM table or
subroutine variant, for example—use the range list boxes at the bottom of the
dialog box.
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3.5.3  Comparing Code Memory to File
The File menu’s Compare program and file... menu command displays a dialog box
for specifying the program file for the comparison.

� Comparing Complete Program
Specifying a file with the extension .hxh or .hxl compares the program code to the
contents of the corresponding program code file pair.

� Limiting the Range
To compare only the program code within a specific address range, use the range
list boxes at the bottom of the dialog box.
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3.6  Project Files (.d63 and .s63)

The DT63K debugger and DTS63K simulator provide numerous options for
debugging and simulating user application programs. To simplify the management
of these options, they therefore provide project (.d63 and .s63) files for holding
these settings from one session to the next. This approach also allows the developer
to switch sets of option settings to match the current needs of the work at hand.

� DT63K Debugger Project Files
DT63K debugger project files, with the extension .d63, hold the following option
settings.

z Target device

z Most recently loaded source line information file

z In-circuit emulator settings from the Tools menu’s Options menu command

z Desktop

� DTS63K Simulator Project Files
DTS63K simulator project files, with the extension .s63, hold the following option
settings.

z Target device

z Most recently loaded source line information file

z Settings from the Tools menu’s Options menu command

z Most recently loaded LCD data file

z Most recently loaded port data file

z Desktop
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4 . Program Execution

4.1  Program Execution

The DT63K debugger, which requires connection to an in-circuit emulator,
executes the user application program in a hardware environment approaching that
of the finished application.

The DTS63K simulator, on the other hand, simulates instructions one at a time.
Because this simulation is at the instruction and not the instruction state level, it
makes no guarantees as to the accuracy of timing for such things as peripheral I/O.

� Continuous Execution
The Run menu’s Run program menu command starts continuous execution. This
execution continues until a break condition is satisfied or you force a break.

The DTS63K simulator’s LCD window simulates an LCD panel by tracking the
contents of the display registers (DSPR).

Instruction execution speed with the DTS63K simulator depends on development
host performance. The Tools menu’s Options menu command therefore provides a
wait setting for slowing down the simulation.

� Single-Step Execution
The Run menu’s Step into menu command executes program code one instruction
at a time. You are therefore able to trace program execution in detail, examining
the contents of peripheral registers (SFR), registers, and data memory locations
after each instruction.

If the instruction is a subroutine call, execution stops at the entrance to that
subroutine.

If an interrupt intervenes, the instruction executed is the first one in the interrupt
service routine.

� Step Over Execution
This variant of single-step execution is only available with the DTS63K simulator.
The Run menu’s Step over menu command executes program code one instruction
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at a time unless that instruction is a subroutine call. In that case, it treats the entire
subroutine—everything from the call instruction through to the return instruction—
as a single instruction.

If an interrupt intervenes, the instruction executed is the first one after the interrupt
service routine returns.

Because this variant skips over subroutines and interrupt service routines, it is most
useful for testing mainline execution.

� Suspending Program Execution
Temporarily suspending program execution is called a break. The software
provides a wide variety of automatic breaks based on conditions that you specify.
For further details, see Chapter 5 “Break Functions.”

� Stop melody playback
When the DTS63K simulator melody function is used, melody playback continues
even after program execution is interrupted by a break. Select Stop melody play
from the Execution menu to forcibly stop melody playback.

� IE Bits
Each code memory address has an Instruction Executed (IE) bit indicating whether
the instruction at that address has been executed. The current state appears in the I
column in Disassembly windows.

IE bit. A mark indicates that the
instruction has been executed.
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4.2  Resets

� CPU Reset
Offered only by the DT63K debugger, the Run menu’s Reset CPU menu command
resets the target device in the in-circuit emulator.

� System Reset
Offered only by the DT63K debugger, the Run menu’s Reset system menu
command resets the in-circuit emulator hardware and software.

� Simulator Reset
Offered only by the DTS63K simulator, the Run menu’s Reset simulator menu
command resets the software. For further details, see Section 13.2 “Resets.”

� Specifying Reset Scope
The Run menu’s Choose reset object... menu command displays a dialog box with
options for clearing the cycle counter, IE bits, and trace memory as part of system
(DT63K) or simulator (DTS63K) reset.
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5 . Break Functions

5.1  Breakpoints

 A breakpoint is a user-specified address at which program execution is
temporarily suspended whenever the user application program attempts to execute
the instruction at that address. You can have multiple address specifications in
effect at the same time.

5.1.1  Setting Breakpoints

� On the Source Window
The current breakpoint state for each instruction appears in the BP column in
Source windows and in the B column in Disassembly windows. A dark square
indicates a breakpoint. Clicking a box toggles this setting on and off.

� On the Disassembly Window
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5.1.2  Listing and Suspending Breakpoints
The Run menu’s List breakpoints... menu command lists all current breakpoint
settings.

Toggle button: Clicking the left mouse button on this button
temporarily disables the selected breakpoints
without deleting them from the list. Clicking it a
second time re-enables them.

Add... button: Clicking the left mouse button on this button
displays a dialog box for adding a new breakpoint
to the list.

Jump button: Clicking the left mouse button on this button
displays the Source window containing the
specified address.
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5.2  Executing to Cursor

The Run menu’s Execute to cursor menu command produces execution from the
current program counter position through to the line containing the cursor in the
active Source or Disassembly window. These windows indicate this line with an
underline.

5.3  Forced Break

Execution normally continues until the program hits a breakpoint or satisfies a
break condition, but you can force a break at any time.

In the DT63K debugger, click the left mouse button on the Stop button in the
dialog box on the screen.

In the DTS63K simulator, choose the Run menu’s Stop program menu command.

5.4  DT63K Break Conditions

The Run menu’s Break conditions... menu command displays the dialog box
controlling break conditions.

DT63K
DTS63K

DT63K

DT63K
DTS63K

DT63K

DTS63K



5. Break Functions

32

The check boxes on the left represent break conditions provided by the in-circuit
emulator. These are totally independent, so you can specify as many or as few as
you like. They are also independent of the setting in the right half.

The radio buttons on the right represent mutually exclusive choices applicable only
during execution with the Run menu’s Run program menu command, not with the
Execute to cursor menu command.

Clicking the left mouse button on the Parameters button displays the dialog box for
specifying the parameters for the selected radio button.

5.4.1  Break Condition Check Boxes

� Breakpoint
Selecting this check box produces a break when the program counter hits an
enabled breakpoint.

� Cycle counter overflow
Selecting this check box produces a break when the cycle counter increments past
16777215.

� Trace Full
Selecting this check box produces a break when the trace memory overflows.

� External
Selecting this check box produces a break when the in-circuit emulator receives
input from the probe cable’s external break pin.

� Power Down
Selecting this check box produces a break when the program switches to HALT
mode with the HALT instruction. Note that the in-circuit emulator automatically
forces the target device out of the HALT mode.

� Call Stack Overflow
Selecting this check box produces a break when the program counter stack under-
or overflows.

� Register Stack Overflow
Selecting this check box produces a break when the register stack under- or
overflows.
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5.4.2  Break Parameters

� None
Selecting this radio button produces no breaks in this category.

� Address Pass Count Break
Selecting this radio button produces a break when the program counter has visited
the specified address the specified number of times. Clicking the left mouse button
on the Parameters button displays the dialog box for specifying the address and the
count.

� RAM Data Match Break
Selecting this radio button produces a break when an instruction in the specified
code memory address range writes the specified masked data to the specified data
memory address the specified number of times. Clicking the left mouse button on
the Parameters button displays the following dialog box.

Address: Data memory address to monitor

Data: Write data to monitor

Mask: Mask to apply to write data

Count: Matches to count

Break address range: Code memory addresses to monitor. Leaving both these
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fields blank extends coverage to the entire code memory.
Leaving the second one blank monitors the single address
in the first one.

� RAM Address Access Break
Selecting this radio button produces a break when the user application program
accesses (write access only) the specified masked data memory address the
specified number of times. Clicking the left mouse button on the Parameters button
displays the following dialog box.

Address: Data memory address to monitor

Mask: Mask to apply to address

Count: Matches to count

� Internal ROM Table Data Match Break
Selecting this radio button produces a break when an instruction in the specified
code memory address range reads the specified masked data from the specified
internal ROM table address the specified number of times. Clicking the left mouse
button on the Parameters button displays the following dialog box.

Address: Internal ROM table address to monitor

Data: Read data to monitor

Mask: Mask to apply to read data

Count: Matches to count
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Break address range: Code memory addresses to monitor. Leaving both these
fields blank extends coverage to the entire code memory.
Leaving the second one blank monitors the single address
in the first one.

� Internal ROM Table Address Access Break
Selecting this radio button produces a break when the user application program
accesses (read only) the specified masked internal ROM table address the specified
number of times. Clicking the left mouse button on the Parameters button displays
the following dialog box.

Address: Internal ROM table address to monitor

Mask: Mask to apply to address

� External Memory Data Match Break
Selecting this radio button produces a break when an instruction in the specified
code memory address range reads/writes the specified masked data from/to the
specified external memory address the specified number of times. Clicking the left
mouse button on the Parameters button displays the following dialog box.

Address: External memory address to monitor
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Data: Read/write data to monitor

Mask: Mask to apply to read/write data

Access: Type of access

Break address range: Code memory addresses to monitor. Leaving both these
fields blank extends coverage to the entire code memory.
Leaving the second one blank monitors the single address
in the first one.

� External Memory Address Access Break
Selecting this radio button produces a break when the user application program
accesses (for either a read or a write) the specified masked external memory
address the specified number of times. Clicking the left mouse button on the
Parameters button displays the following dialog box.

Address: External memory address to monitor

Mask: Mask to apply to address
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5.5  DTS63K Break Conditions

The Run menu’s Break conditions... menu command displays the dialog box
controlling break conditions.

Clicking the left mouse button on the Parameters button displays the dialog box for
specifying the parameters for the selected radio button.

5.5.1  Break Condition Check Boxes

� Breakpoint
Selecting this check box produces a break when the program counter hits an
enabled breakpoint.

� Cycle counter overflow
Selecting this check box produces a break when the cycle counter increments past
2147483647.

� Trace Full
Selecting this check box produces a break when the trace memory overflows.

� Call Stack Overflow
Selecting this check box produces a break when the program counter stack under-
or overflows.

� Register Stack Overflow
Selecting this check box produces a break when the register stack under- or
overflows.
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5.5.2  Break Parameters

� None
Selecting this radio button produces no breaks in this category.

� Address Pass Count Break
Selecting this radio button produces a break when the program counter has visited
the specified address the specified number of times. Clicking the left mouse button
on the Parameters button displays the dialog box for specifying the address and the
count.

� RAM Data Match Break
Selecting this radio button produces a break when an instruction in the specified
code memory address range writes the specified masked data to the specified data
memory address the specified number of times. Clicking the left mouse button on
the Parameters button displays the following dialog box.

Address: Data memory address to monitor

Data: Write data to monitor

Mask: Mask to apply to write data

Count: Matches to count

Access: Type of access

Break address range: Code memory addresses to monitor. Leaving both these
fields blank extends coverage to the entire code memory.
Leaving the second one blank monitors the single address
in the first one.
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� RAM Address Access Break
Selecting this radio button produces a break when the user application program
accesses (for either a read or a write) the specified masked data memory address
the specified number of times. Clicking the left mouse button on the Parameters
button displays the following dialog box.

Address: Data memory address to monitor

Mask: Mask to apply to address

Count: Matches to count
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6 . Displaying/Modifying Memory and Registers

6.1  Program Counter

The current contents of the program counter appear in the Status window.

To change them, right-click on the window and choose the Change program
counter... menu command.

It also possible to monitor the contents by adding the program counter to the watch
list in a Watch window.

Source and Disassembly windows highlight the line containing the program
counter.

6.2  Registers

The registers appear in a Register window.

To change the contents of a register, right-click on the window and choose the
appropriate Change xxx... menu command.
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� Accumulator (A)
This field shows the contents of the accumulator. Modify them with the Change A...
menu command.

� XY Register
This field shows the contents of the XY register. Modify them with the Change
XY... menu command. The dialog box splits the register into X and Y registers.

� HL Register
This field shows the contents of the HL register. Modify them with the Change
HL... menu command. The dialog box splits the register into H and L registers.

� Carry (C) Flag
This field shows the contents of the carry flag. Modify them with the Change C
flag... menu command.

� Zero (Z) Flag
This field shows the contents of the zero flag. Modify them with the Change Z
flag... menu command.

� G Flag
This field shows the contents of the G flag. Modify them with the Change G flag...
menu command.

� Current Bank Register (CBR)
This field shows the contents of the current bank register. Modify them with the
Change CBR... menu command.

� Extra Bank Register (EBR)
This field shows the contents of the extra bank register. Modify them with the
Change EBR... menu command.

� RA Registers (RAx)
This field shows the contents of the RA registers. Modify them with the Change
RAx... menu command.

� Master Interrupt Enable (MIE) Flag
This field shows the contents of the master interrupt enable flag. Modify them with
the Change MIE flag... menu command.
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� Register Stack Pointer (RSP)
This field shows the contents of the register stack pointer. Modify them with the
Change RSP... menu command.

� Stack Pointer (SP)
This field shows the contents of the stack pointer. Modify them with the Change
SP... menu command.

6.3  Peripheral Registers (SFRs)

The contents of peripheral registers appear in an SFR window. To modify a register,
right-click on it and choose the Change value menu command.

� Searching SFRs
The context menu also contains a Find menu command for searching the SFR list
by name.

� Adding to Watch List
To add an SFR to the watch list in the Watch window, right-click on it and choose
the Add to watch menu command to display the Add watch item dialog box with
the selected SFR in the Item field.

DT63K
DTS63K



6.4 Code, Data, and External Memory

43

6.4  Code, Data, and External Memory

� Dumping Memory
The View menu contains three items that open windows for displaying memory for
editing: Code, Data, and External data.

An External data window provides a dump listing of external data memory
contents.

A Data window is the counterpart for data memory. Note, however, that it blocks
modification in the SFR region. Use an SFR window instead.

A Code window is the counterpart for program memory. Its primary use is for
editing ROM table data. A Disassembly window is more useful for instructions
because it displays instruction mnemonics and not just the machine code.

The DTS63K simulator requires that external memory first be enabled with the
Tools menu’s Options menu command.

� Modifying Contents
Right-clicking on the window and choosing the Change menu command displays
the following dialog box for modifying window contents.

The Values list box accepts a list delimited with spaces, commas, or semicolons.
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� Code Memory Assembler
The Code window Values list box also accepts an assembly language instruction.
In this case, clicking the left mouse button on the OK button does not close the
dialog box. The dialog box acts as a single-line editor, incrementing the starting
address field in preparation for the next instruction.

� Jumping to an Address
The Jump menu command on dump window context menus displays a dialog box
for jumping to a specific address in that window.

� Filling Memory
The Fill menu command on dump window context menus displays a dialog box for
filling the entire memory with the same value—the quick way to initialize data or
external data memory.
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7 . Watch Windows

7.1  Watch Window Usage

A Watch window is for displaying the contents of such items as data addresses,
registers, and peripheral registers (SFRs).

Item specifications can use label symbols, indirect addressing with the HL, XY,
and RA registers, and other complex addressing modes.

The View menu’s Watch menu command opens a new Watch window. Note that
you can open multiple Watch windows, each with its own list of items. When you
first open a Watch window, this list is empty. To add items, right-click on the
window and choose the Add to watch menu command.

7.2  Candidates

The following means are available for adding to Watch windows.

• Program counter

• Registers: A, H, L, HL, X, Y, XY, CBR, EBR, RA0, RA1, RA2, RA3, RA,
RSP, and SP

• Flag bits: C, Z, G

• Data memory address

• Peripheral registers (by SFR name)

• Indirect address in HL

• Extra bank indirect address in HL

• Indirect address in XY

• Extra bank indirect address in XY

• Indirect program memory address in RA register

• Indirect external memory address in RA register

• PC-based address (PC+A)
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7.3  Adding Items

� Watch Window
Right-clicking on the window and choosing the Add to watch menu command
displays the following dialog box.

Item: Item to add

Number: Number of data items to display (data addresses only)

Reverse: Display data items in descending address order

RA target: Destination for RA register indirect addressing: code or external
data memory

Display format: Radix for displaying data

� Source Window or Disassembly Window
To add a label or other identifier to the watch list, right-click on it and choose the
Add to watch menu command.

To add text consisting of more than just a single word—[HL], for example—
highlight it before right-clicking.

� SFR Window
To add an SFR to the watch list, right-click on it and choose the Add to watch
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menu command.

� Symbol List
The Tools menu’s Symbol list menu command displays a dialog box with all
symbols. To add a symbol to the watch list, select it and click the left mouse button
on the Add to watch menu command.

7.4  Saving Watch List

Right-clicking on the window and choosing the Save watch list menu command
displays a dialog box for saving the current list of watch items to a disk file.

7.5  Loading Watch List

Right-clicking on the window and choosing the Load watch list menu command
displays a dialog box for reading a watch item list back in—to avoid having the
rebuild the same list several days in a row, for example. Note, however, that what
is saved is only the specifications lists. Loading a watch list displays the current
contents of the items, not the ones in effect when the file was saved.

7.6  Modifying Watch List

The Watch window context menu provides additional commands for modifying the
list in the window.

� Reordering Items
The Up menu command moves the selected item higher in the list; Down, lower.

� Changing Radix
The Properties... menu command displays a dialog box with radio buttons for
specifying the radix for the selected item.

� Deleting Items
The Delete menu command removes the selected item from the list; Delete all, all
items.
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8 . Tracing

8.1  Overview

When the microcomputer is connected to an embedded system busy controlling
equipment, it is not always possible to interrupt execution with breaks for checking
purposes or to use single-step execution. In such a situation, you can use the in-
circuit emulator’s trace function to take samples during emulation execution and
debug by analyzing the results of that sampling. This function records operational
data at key points in trace memory. To view the contents, open a Trace window.
(See Section 8.2 “Trace Windows” below.)

� Displaying Trace Pointer
The trace pointer indicates the current trace entry position in the trace memory. The
current contents appear in the Status window.

� Clearing Trace Memory
The Trace menu’s Clear trace memory command clears the trace memory.

� Trace Memory Size
The in-circuit emulator attached to the DT63K debugger has room for 8192 trace
entries; the DTS63K simulator, 65,536.

When the trace memory is full, the trace pointer automatically wraps to 0 upon
overflow so that new trace entries overwrite the old.

8.2  Trace Windows

The View menu’s Trace menu command opens a Trace window. If the trace
memory is empty, so is the window.

This window displays the trace items in chronological order: oldest item at the top,
most recent item at the bottom.

Across the top of the window are labels for the individual fields.
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� Trace Pointer (Loc)
This column specifies the trace pointer, an index to the trace memory entries. It
also provides a rough time scale for the contents.

� Program Counter (PC)
This column normally gives the program counter location at the time of the trace.

� Accumulator (A)
This column normally gives the contents of the Accumulator (ACC) after execution
of the instruction at the code address in the PC column.

� RAM Address (RADR)
This column gives the last data address accessed by an instruction writing to
memory.

� RAM Data (RD)
This column normally gives, depending on the instruction traced, either the last
value written to data memory.

� Flags (CGZ)
These columns give the contents of the carry (C), G, and zero (Z) flags after
execution of the instruction at the code address in the PC column.

� Master Interrupt Enable Flag Register (MI)
This column gives the contents of the Master Interrupt Enable (MIE) flag after
execution of the instruction at the code address in the PC column.

� Melody Request Flag (MD)
This column gives the contents of the Melody Request Flag (MD) after execution
of the instruction at the code address in the PC column.

� Current Bank Register (CB)
This column gives the contents of the Current Bank Register (CBR) after execution
of the instruction at the code address in the PC column.

� Extra Bank Register (EB)
This column gives the contents of the Extra Bank Register (EBR) after execution of
the instruction at the code address in the PC column.
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� HL Register (HL)
This column gives the contents of the HL Register (HL) after execution of the
instruction at the code address in the PC column.

� XY Register (XY)
This column gives the contents of the XY Register (XY) after execution of the
instruction at the code address in the PC column.

� PC Stack Pointer (SP)
This column gives the contents of the Stack Pointer (SP) after execution of the
instruction at the code address in the PC column.

� Register Stack Pointer (RS)
This column gives the contents of the Register Stack Pointer (RSP) after execution
of the instruction at the code address in the PC column.

�  External Probe Data (XP)
This column gives the contents of the states of external probe pins after execution
of the instruction at the code address in the PC column.

� Interrupt Notification (I)
 A “1” in this column indicates an interrupt during execution of the instruction at
the code address in the PC column. Tracing switches to the interrupt service routine
from the next line.

� External/ROM Data Access Notification (E)
A “1” in this column indicates that this entry contains the external data memory
address or internal ROM table address accessed by the instruction at the code
address in the PC column for the preceding entry—in other words, that the entry
represents a continuation of the preceding entry and has that address in the PC
column.

� Source/Disassembler
The context menu’s Properties... menu command offers a choice for this column:
source code or disassembler output for the instruction currently at the code address
in the PC column.
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8.3  Tracing Options

The Trace menu’s Settings menu command displays the following dialog box.

Free: Remove address limits on tracing

Trigger: Toggle tracing using address ranges specified below

None: Disable tracing

Use trace points: Limit tracing to trace points. Note that this option can be
freely mixed with the address triggers.

On triggers: Enable tracing whenever the program counter visits a code
memory address in the specified range. Leaving both these
fields blank extends coverage to the entire code memory.
Leaving the second one blank makes the first one the only
trigger.

Off triggers: Disable tracing whenever the program counter visits a code
memory address in the specified range. Leaving both these
fields blank extends coverage to the entire code memory.
Leaving the second one blank makes the first one the only
trigger.

Note that the trigger trace mode traces the execution of instruction at on trigger
addresses, but not the ones at off trigger addresses.
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The DTS63K simulator Trace window’s Options menu command displays the
following dialog box.

Selecting the Tracing on check box enables tracing.

Selecting the Trace steps check box enables tracing during single-step execution.
Note that this check box is only available when the first is selected.

8.4  Saving Trace Data

The Trace menu’s Save trace data menu command displays the following dialog
box for saving the trace memory contents to a disk file.

The list boxes at the bottom allow you to limit the operation to a specific address
range. Leaving them blank extends coverage to the entire trace memory.
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8.5  Searching Trace Data

Right-clicking on the window and choosing the Search menu command displays the
following dialog box for searching individual columns for data matching a specific
masked value.

Column: Column to search

Value: Value to match

Mask: Mask for data

Count: Repetition count

Direction: Direction to search
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9 . Cycle Counter

9.1  Overview

If your system demands real-time response, you frequently wish to know precisely
how long certain sequences take to execute. The software can help by counting
execution cycles.

This execution cycle counting function works by counting the clock cycles fed to
the target device while it is executing. Note that with OLMS-63K microcomputers,
the number of cycles depends on the instruction. The cycle counter counts all such
cycles.

� Displaying Cycle Counter
The current cycle counter contents appear in the Status window.

The context menu’s Properties... menu command provides a choice of count or time
formats.

� Changing Cycle Counter
To change the cycle counter, choose the CycleCounter menu’s Change menu
command.

� DT63K Debugger Cycle Counter
The cycle counter in the in-circuit emulator is a 24-bit unsigned one that overflows
after 16,777,215.

� DTS63K Simulator Cycle Counter
The cycle counter in the DTS63K simulator is a 31-bit unsigned one that overflows
after 2,147,483,647. In the DTS63K, when the cycle counter is set to be displayed
as a time, both the number of cycles executed in high-speed program operation and
the number of cycles executed in low-speed program execution are displayed
converted to time values.

� Cycle Counter Overflow
Both the DT63K debugger and DTS63K simulator allow the use of cycle counter
overflow to trigger a break. For further details, see Chapter 5 “Break Functions.”
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9.2  Options

The DT63K debugger CycleCounter menu’s Options menu command displays the
following dialog box.

Free: Remove address limits on counting

Trigger: Toggle counting using address ranges specified below

None: Disable counting

On triggers: Enable counting whenever the program counter visits a code
memory address in the specified range. Leaving both these
fields blank extends coverage to the entire code memory.
Leaving the second one blank makes the first one the only
trigger.

Off triggers: Disable counting whenever the program counter visits a code
memory address in the specified range. Leaving both these
fields blank extends coverage to the entire code memory.
Leaving the second one blank makes the first one the only
trigger.

Note that the trigger count mode counts the execution of instruction at on trigger
addresses, but not the ones at off trigger addresses.

DT63K



9. Cycle Counter

56

The DTS63K simulator CycleCounter menu’s Options menu command displays the
following dialog box.

Selecting the Counting on check box enables counting.

Selecting the Count steps check box enables counting during single-step execution.
Note that this check box is only available when the first is selected.
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10 . Source Level Debugging

10.1  Source Windows

The software supports basic debugging from Source windows displaying the source
code for the user application program. Debugging is much more efficient when you
have the original easy-to-read, fully commented, formatted source code to refer to
instead of just a disassembler listing.

The View menu’s Source menu command opens a Source window.

Line: Line number in the source file

BP: Check box for setting breakpoints

Address: Code address

The green band indicates the line containing the program counter; the underline,
the current cursor position.

� Preparing Source Files
Source windows require source files in a special format from the SASM63K
structured assembler. For further details, see Chapter 2 “Before You Start.”

� Switching Source Files
If the user application program combines files using INCLUDE directives, you will
need a separate Source window for each one. Switch between them with the
Change source windows menu command.
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� Setting Breakpoints
The BP column contains check boxes for breakpoints. Clicking one changes the
color to red to indicate a breakpoint. Clicking a second time cancels the setting.

� Executing to Cursor Line
To execute the program from the current program counter position up to a
particular address in a Source window, right-click on the line for that address and
choose the Execute to cursor menu command from the context menu. If the line
does not contain executable code, however, nothing happens.

Alternate methods for moving the cursor offered by the context menu are the Jump
to address and Jump to line menu commands.

10.2  Links to Other Windows

� Switching to Disassembly Window
Choosing the Disassemble menu command on the Source window context menu
displays the cursor line in a Disassembly window. If the line does not contain
executable code, however, nothing happens.

� Switching from Trace Window
Double-clicking on an address in the PC column of a Trace window displays the
corresponding line in a Source window. If there is no source line information file
loaded, however, the corresponding line in a Disassembly window appears instead.

� Adding to Watch Window
Selecting text in a Source window and choosing the context menu’s Watch menu
command adds that text to the Watch window. For further details, see Chapter 7
“Watch Windows.”
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11 . Symbolic Debugging and Input Formats

11.1  Symbols

Symbols are stand-ins for specific numerical values. They allow you to use easy-to-
remember names instead of numbers for addresses and constants.

The software uses the following rules to recognize symbols in expressions.

• A symbol begins with a letter (A–Z or a–z) or certain special characters (_, $,
and ?).

• Subsequent characters may be the above or digits (0–9).

• The following characters serve as delimiters indicating the end of the symbol:

- whitespace characters tab (09H), line feed (0AH), carriage return (0DH), and
space (20H)

- operators +, -, *, / , %, &, |, ^, !, ., <, >, =, (, and )

- other symbols ¥, [, ], {, }, :, ;, @, #, ,” ‘, and comma (,)

Note: Only the first 32 characters of a symbol are valid.

� Preparing Symbol Tables
Symbolic debugging requires debugging files in a special format prepared by
supplying the /d to the SASM63K structured assembler.

� Symbol Value
This is the value assigned to the symbol.

� Symbol Attributes
Symbols have other attributes beside value.

CODE: Code address symbol

DATA:  Data address symbol

XDATA:  External data address symbol
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BIT:  Bit address symbol

NUMBER:  Numerical value

� Symbol Type
This gives the scope in which the symbol is defined. This type plays an important
role in symbol searches. Types available are: reserved word and user-defined
symbol.

Reserved words are symbols defined in the device-specific .dcl file that the
software reads in during start-up. They are usually the names of peripheral registers
(SFRs) for the microcomputer being evaluated. You cannot modify these symbols.

User-defined symbols are symbols defined in the user application program as labels
or with SASM63K structured assembler directives EQU, CODE, DATA, XDATA,
etc. They are thus eligible for modification or even deletion.

� Displaying Symbol List
The Tools menu’s Symbol list menu command displays a dialog box listing all
reserved words and user-defined symbols. This dialog box also provides facilities
for adding, deleting, and changing the values assigned to user-defined symbols.

11.2  Expressions

The software supports expressions built up from three basic components: constants,
operators, and symbols. Before discussing the expression syntax itself, let us define
these components.

Integer constants
(1) Constant

Character constants

Arithmetic operators
Expression (2) Operator

Dot operator

Reserved word symbols
(3) Symbol

User-defined symbols
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11.2.1  Constants
Constants directly specify addresses and data values. There are two basic types:
integer and character constants.

� Integer Constants
These are strings beginning with a digit (0–9) and consisting entirely of the
characters listed for the radix (2, 8, 10, or 16) in the table below.

If a string starts with a character other than a digit—i.e., A–F, a–f, or underscore—
prefix it with a zero to prevent parsing as a symbol. Underscores and case are
ignored.

Radix Permissible
Characters

Suffixes Examples

2 0, 1, _ B 1010B

8 0~7, _ O, Q 271O, 514Q

10 0 to 9, _ 1234

16 0 to 9, A to F, a to f, _ H 753H, 0C6E7H

� Character Constants
These consist of a pair of single quotes (‘) around a single character or a (pre-
ANSI) C-like escape sequence starting with ASCII character 5CH, the backslash
(or yen sign in Japanese fonts).

In the first case, the integer constant has the 8-bit value corresponding to the ASCII
code for that character.

A backslash after the opening quote introduces an escape sequence, which specifies
the integer constant as an 8-bit octal or hexadecimal constant between 00H and
0FFH.
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11.2.2  Operators
The software evaluates expressions using unsigned 32-bit arithmetic, automatically
converting negative values to their twos complement form and ignoring any
overflow.

� Arithmetic Operators
+ Binary addition

- Binary subtraction

& Binary AND

� Dot Operator
. Equivalent to left operand * (number of bits) + right operand

This operator expresses a bit address relative to a data address.

11.3  Value Lists

In a dump list window, the context menu’s Change xxx... menu command displays
a dialog box with a Values list box. This accepts a list delimited with spaces,
commas, or semicolons.
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12 . Other Functions

12.1  Macros

The software includes a text-based macro facility that executes text-based scripts
created in a text editor. All output goes to the Log window. A complete command
listing appears in Section 15.4 “Macro Command Reference.”

The Tools menu’s Macro menu command displays the following dialog box for
choosing a macro file.

During macro execution, all output goes to the Log window. You can, if you wish,
save the contents of this window to a disk file.
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12.2  Log Window

The Log window keeps a record of debugging and simulation operations.

It also provides a simple text editor for editing the window’s contents: deleting
unnecessary portions, searching and replacing strings, adding comments to macro
output, etc.

The Tools menu’s Log menu command opens the Log window.

This window holds the following data.

• Output from macro execution

• Results of comparing code memory and program files

• Results of comparing code memory and EPROM (DT63K debugger only)

• Text

12.3  On-Line Help

The software includes a Windows help file providing assistance for all menus,
context menus, windows, and dialog boxes.

When a menu or dialog box is on the screen, pressing the F1 key displays the
related portion of this file. Otherwise, the key is equivalent to the Help menu’s
Help topic menu command, which displays an index for the help file.

� Contents
Clicking the Contents tab displays the table of contents for the help file. Double-
clicking an item either expands that portion of the outline or displays the text for
that topic.
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� Keywords
Clicking the Keywords tab displays an index that automatically searches for
keywords as you type.

12.4  Version Information

The Help menu’s About menu command displays a version number and other
information about the software.

The DT63K debugger displays hardware and firmware version numbers for the
connected emulator as well.
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12.5  Reading/Verifying EPROMs

These functions are available only for in-circuit emulators with EPROM sockets.

� Loading Code from EPROM
The Tools menu’s Load from EPROM menu command displays the dialog box for
loading all or some of the contents of the EPROM into code memory.

� Comparing Code to EPROM
The Tools menu’s Compare to EPROM menu command displays the dialog box for
comparing all or some of the contents of code memory to the EPROM.
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13 . DTS63K Simulation Functions

13.1  Instruction Execution

The software simulates nX-4/250 core instructions at the instruction level and
makes no guarantees as to the accuracy of timing. Hardware-dependent portions
require particular care because the timing depends on development host
performance during the computations necessary for the simulation, not the target
device’s true execution cycle.

The Run menu’s Run program menu command starts continuous execution. This
execution continues until a break condition is satisfied or you force a break with
the Run menu’s Stop execution menu command.

This section describes the features of this simulation.

� Operating Frequency
The only operating frequency under user control is the high-speed clock. The
controls are on the dialog box displayed by the Tools menu’s Options menu
command.

� Wait Between Instructions
Because the simulation of the target device and peripherals takes place entirely
within the memory of the development host, instruction execution speed can be
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much faster. The dialog box displayed by the Tools menu’s Options menu
command therefore provides a wait setting for slowing down the simulation.

When a wait time is set, operation timing in which waits can be inserted once every
few instructions can be specified by checking the “Wait setting” check box.

� Instruction Set
The simulation covers all nX-4/250 core instructions.

� Memory Spaces
The simulation supports the following memory spaces.

• Program memory (max. 64K words)

• Data memory (max. 4K nybbles)

• External data memory (max. 64K bytes)

� Register Set
The software simulates the operation of the following registers.

• Accumulator (A)

• Flag register (C, Z, and G flags)

• Master interrupt enable (MIE) flag

• Current bank register (CBR)

• Extra bank register (EBR)

• HL register

• XY register

• Program counter (PC)

• RA registers (RA0, RA1, RA2, and RA3)

• Stack pointer (SP)

• Register stack pointer (RSP)

13.2  Resets

When the DTS63K simulator loads or you choose the Run menu’s Reset simulator
menu command, the simulation resets itself to imitate the target device’s reset cycle
when the device first receives power or subsequently receives reset input.
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The reset sequence includes the following steps.

• Resetting the nX-4/250 core

• Initializing peripheral registers (SFRs)

• Resetting the break status to “Not yet executed”

The Run menu’s Reset options menu command provides controls for optionally
clearing the cycle counter, IE bits, and trace memory as well.

Note that the DTS63K simulator does not support resets with RESET pin input.

13.3  Onboard Peripherals

The software simulates the following peripheral functions built into the target
device.

� Time Base Counter (TBC)
The software simulates a 15-bit time base counter. This counter increments at the
falling edge of the 32.769-kHz time base clock signal. Counter outputs include the
time base interrupt and operating clock signals for circuit modules.

After a reset, the counter contains the value 0000H.

� Timers
The software simulates four 8-bit timers, numbered 0 to 3, but only in their auto
reload modes. It does not support the capture mode offered by timers 0 and 1 or the
frequency measurement mode offered by all four.

The only choices for the timer input clocks are the 32.769-kHz time base clock and
the high-speed clock. There is no support for external clocks.

� 100-Hz Timer/Counter
The software uses internal calculations to simulate a 100-Hz timer/counter. The
one in actual devices derives its input clock from the 512-Hz TBC6 output with a
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frequency divider.

� Watchdog Timer (WDT)
The software simulates a watchdog timer, running off TBC7 output, for
automatically interrupting a program that has run out of control.

� Ports
The software simulates all port registers, port control registers, port interrupt
enable registers, and port mode registers available for the target device.

It also simulates most secondary port functions—except for the following.

• Extended LCD driver frame output

• Extended LCD driver clock output

• 32.768-kHz crystal oscillator clock output

• High-speed oscillator clock output

• Shift register data input

• Shift register data output

• Shift register clock I/O

• Capture input for timers 0 and 1

• External clock input for timers 0 to 3

The I/O port simulation supports two methods of assigning port inputs to keys on
the development host’s keyboard: one-to-one mapping and a key matrix.

The first approach uses the Change key assignments... menu command from the
Tools menu context or the Port window’s context menu.
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Select the input port and key from the corresponding columns and specify the
connection with the radio buttons: push-button or on/off switch, “High” level input
or “Low.”

The Connect to other port radio button enables the output port column, connecting
the selected output port to the input port.

The key matrix approach uses the matrix variant of the Port window. For further
details, see Section 3.4.2 “Assigning Ports.”

The port registers, port control registers, port interrupt enable registers, and port
mode registers are accessible in the SFR window.

� External Data Memory
The software uses 64K of memory in place of the external data memory and
simulates the related secondary port functions. It does not simulate expansion with
a chip select (CS) or the operation of the external circuitry, however.

� Melody Driver
The software simulates the melody driver, but the speed difference between
simulated and hardware instruction produces a large difference in the timing for the
end of the melody.

The software converts the melody data from the ROM table into .WAV format for
output to the development host speaker.

� Buzzer Driver
The software simulates the buzzer driver, converting buzzer output into beeps from
the development host speaker.

� Serial Ports
The simulation does not cover these.

� Shift Registers
The simulation does not cover these.

� LCD Driver
The simulation covers the following portions of the LCD driver.

• Maximum number of dots supported by target device

• Duty selection

• All segments off
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• All segments on

• 16 contrast levels

• Power down mode

It does not support bias selection.

The simulated LCD screen appears in the LCD window. For further details, see
Section 13.5 “LCD Simulation” below.

� Multiplier/Divider Circuit
The simulation covers the multiplier/divider circuit, substituting the appropriate
calculations. It does not simulate the circuit itself.

� Battery Low Detector
The simulation does not include the circuit for detecting low battery level. The
corresponding control register, however, still appears in the SFR window.

� Backup Circuit
The simulation does not cover the backup circuit. The corresponding control
register, however, still appears in the SFR window.

13.4  Interrupt Simulation

The software simulates the interrupt service routines for processing interrupts
arriving during program execution. This simulation completely supports stack
operations, the disable interrupt instruction, and other related details.

The simulation covers all interrupts, but external interrupts are limited to those
generated from keys mapped to the corresponding ports in the Port window.

An interrupt during HALT mode release the simulated target device from that
mode.

13.5  LCD Simulation

A major simulator feature is its simulation of an LCD screen in the LCD window.
Using it, however, requires some outside preparation.
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1. Create the LCD screen with a graphics package and save it in Windows bitmap
(.BMP) format.

2. Assign common outputs, segment outputs, and display registers (DSPRs) with
LCDTOOL. If desired, add a dot matrix. Save the results as an LCD data file.

3. Load the LCD data file into the simulator with the File menu’s Load LCD
graphics menu command.

4. Open the LCD window to display the bitmap.

5. Run the program to see its effects on the simulated LCD screen in the LCD
window.

For further details on the LCDTOOL utility, see Chapter 14 “LCDTOOL Utility”
below.

� LCD Screen Refresh Period Setting
The DTS63K simulator supports setting the LCD window screen refresh period
during simulation.

The LCD screen refresh period can be set to a value in the range 55 to 550 ms.

To set the LCD screen refresh period, select Operation settings from the Tools
menu and use the LCD Display item in the dialog box.

Create display with
graphics software

Assign common outputs, segment outputs,
and DSPRs with LCDTOOL

LCD data file
Simulate LCD screen
in DTS63K window

W indows bitmap
(.BMP) file
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14 . LCDTOOL Utility

14.1  Overview

LCDTOOL is a utility that prepares LCD data files for the DTS63K simulator.
Either load it directly (LCDTOOL.EXE) or with the Tools menu’s LCDTOOL
menu command.

The utility takes as input a Windows bitmap (.BMP) created with a suitable
graphics package. Its function is to assign common outputs, segment outputs, and
display registers (DSPRs) to drive this display.

When these assignments are complete, save the results as an LCD data file for
loading into the simulator.

14.2  Procedure

The procedure for creating an LCD data file for loading into the simulator consists
of the following steps.

1. Create the .BMP file.

2. Load this file into LCDTOOL.

3. (Optional) Add dot matrix.

4. Make assignments.

5. Save results as LCD data file.

14.2.1  Creating .BMP File
The first step is creating the desired LCD screen image. One tool for the job is MS
Paint, included with Windows, but any graphics package capable of saving in
Windows bitmap (.BMP) format will do.

If the display uses a dot matrix, leave that area blank. LCDTOOL contains a
convenient tool for automatically adding dot matrices.

LCDTOOL
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14.2.2  Loading .BMP Data
The next step is to read the graphics data into the utility with the File menu’s Open
menu command.

The graphic then appears on the screen with tool palettes.

                              Graphics data read

14.2.3  Creating Dot Matrix
While the size of the dot matrix is set to a default of 16 common lines by 32
segment lines, those values can be changed using the Common/segment numbers
item in the Tools menu.

LCDTOOL

LCDTOOL

Area reserved for dot
matrix

Windows bitmap
(.BMP) file



14. LCDTOOL Utility

76

To add a dot matrix to this display, choose the Tools menu’s Create dot matrix
menu command to display the following dialog box for specifying the size and
other parameters.

The two radio buttons at the top specify the orientation for common vs. segment
outputs.

The Dot count controls specify the number of dots in the vertical and horizontal
directions. The maximum values of those settings are the number of common lines
(vertical) and number of segment lines (horizontal) settings specified with the
Common/segment numbers item in the Tools menu. The two controls in the second
line specify the dot height and width in pixels. The third line gives the spacing
between dots in pixels; the fourth, the coordinates of the upper left corner of the
matrix.

The controls in the Common and Segment areas specify the order for assigning
outputs from left to right and the starting number. Selecting None for the former
disables automatic assignment.



14.2 Procedure

77

                                  New dot matrix

14.2.4  Making Assignments
To assign common and segment outputs to a bit map region, click on it to display
the Assign segments dialog box. To select multiple regions, hold down the Ctrl key
for each one except the last. Note that assigned regions appear in light blue.

The Type radio buttons portion of the dialog box specifies the type of assignment
and the layout of the bottom half.

COM: Common

SEG: Segment

COM/SEG: Both common and segment

DSPR: Display register value

� Assigning Common Outputs
Selecting the COM radio button displays the following dialog box.

Specify the common output number and click the left mouse button on the Assign
button.

LCDTOOL
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� Assigning Segment Outputs
Selecting the SEG radio button displays the following dialog box.

Specify the segment output number and click the left mouse button on the Assign
button.

� Assigning Common and Segment Outputs
Selecting the COM/SEG radio button displays the following dialog box.

Specify the common and segment output numbers and click the left mouse button
on the Assign button.

� Assigning by DSPR Value
Selecting the DSPR radio button displays the following dialog box.
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Specify the display register and bit numbers and click the left mouse button on the
Assign button. The mapping between display register bits and outputs appears in
the User’s Manual for the target device.

� Displaying Assignments
The Force display dialog box is for checking assignments for bitmap regions.

Assigned: All assigned bitmap regions

COM: Bitmap regions for specified common output

SEG: Bitmap regions for specified segment output

DSPR: Bitmap regions for specified display register

Selecting the All check box lights up all bitmap regions with assignments of the
specified type.

Moving the mouse cursor to a bitmap region displays its current common, segment,
and DSPR assignments on the status bar.

14.2.5  Saving LCD Data File
When the assignments are complete, save the results as an LCD data file for
loading into the simulator.

The File menu provides two choices: Save and Save as. The latter is the only one

LCDTOOL
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available when you have just loaded the .BMP file. The former is available only if
you have already saved the data and then edited it.

The default extension for LCD data files is .LCD.
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14.3  Editing LCD Data Files

The File menu’s Open menu command is for loading a previously saved LCD data
file for additional editing.

� Undoing an Edit Operation
The Undo item on the Edit menu undoes the effect of the last edit operation.

� Moving Bitmaps
To move a bitmap region, click on it and drag it to the new position.

� Deleting Bitmaps
The Edit menu offers two choices for deleting the selected bitmap region from the
screen: Cut and Delete. The only difference is that the former moves the data to the
clipboard, making it available for pasting with the Paste menu command.

� Copying Bitmaps
The Edit menu’s Copy menu command copies the selected bitmap region to the
clipboard, from which it is available for pasting with the Paste menu command.

� Bitmap grouping
Multiple bitmaps can be grouped and handled as a single object by selecting the
bitmaps to be grouped and then selecting the Group item on the Edit menu. The
grouped items can be restored to be individual items by selecting the Ungroup item
on the Edit menu.

� Canceling Assignments
To cancel assignments to a bit map region, select it and choose the Edit menu’s
Cancel assignment menu command.

LCDTOOL
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14.4  Other Functions

14.4.1  Zoom
The software provides a convenient zoom control function for enlarging or
reducing the size of the image on the screen for ease in editing. Choose the View
menu’s Zoom menu command to display the following dialog box and select the
new magnification factor.

The list box offers the following choices: 10%, 25%, 50%, 75%, 100%, 150%,
200%, 400%, and 800%.

14.4.2  Operating Settings
The Tools menu’s Settings menu command displays the following dialog box for
configuring operation.

The controls in the first box specify the height and width of the LCD screen in
pixels.

Next comes the default magnification to use when the simulator loads the LCD
data file.

LCDTOOL
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The large box specifies the colors for indicating assignments—with the Force
display dialog box, for example.

14.4.3  On-Line Help
The Help menu’s Help topics... menu command displays a dialog box for searching
the on-line help by topic. Enter a keyword and click the left mouse button on the
Display button.

Clicking the left mouse button on the help button on the tool bar changes the cursor
icon. Clicking on a window, dialog box, tool bar icon, etc. then displays the
corresponding portion of the help file.

LCDTOOL
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15 . Appendices

15.1  DT63K Debugger

15.1.1  Menus

� File (F)
O = Open project...
S = Save project
A = Save project as...
L = Load program file...
V = Save program to file...
C = Compare program and file...
D = Load external memory data file...
E = Save external memory data to file...
R = Load RAM data file...
M = Save RAM data to file...
X = Exit

� Edit (E)
T = Cut
C = Copy
P = Paste
D = Delete
L = Select all
F = Find...
E = Replace...

� View (V)
S = Source
A = Disassembly
U = Status
R = Registers
F = SFRs
C = Code
D = Data
X = External data
E = Trace memory
W = Watch list

DT63K
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G = Log
T = Tool bar
B = Status bar

� Run (R)
U = Reset CPU
R = Reset system
O = Reset options...
E = Execute program
G = Execute to cursor
T = Reset and restart
S = Step into
C = Change program counter...
B = Toggle breakpoint
K = List breakpoints...
A = Clear all breakpoints
D = Break conditions...
Y = List sync out points
L = Clear all sync out points
I = Clear IE bits

� CycleCounter (C)
C = Clear
H = Change...
S = Settings...

� Trace (T)
C = Clear trace memory
P = List trace points...
A = Clear all trace points
S = Settings...

� Tools (L)
M = Macro
P = Stop macro
S = List symbols...
E = Load from EPROM...
C = Compare to EPROM...
O = Options...
D = Environment settings

� Window (W)
O = Close active window
A = Close all
R = Replicate window
C = Cascade
V = Tile vertically
H = Tile horizontally
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� Help (H)
F = Find help on topic
A = About

15.1.2  Context Menus

� Source Window
G = Execute to cursor
B = Toggle breakpoint
K = List breakpoints...
L = Jump to line...
A = Jump to address...
U = Jump to PC line
D = Disassemble
W = Watch...
M = Move to file...
R = Replicate window
P = Properties...

� Disassembly Window
G = Execute to cursor
B = Toggle breakpoint
K = List breakpoints...
T = Toggle trace point...
L = List trace points...
O = Toggle sync out point
Y = List sync out points...
I = Clear IE bits
A = Jump to address...
U = Jump to PC line
M = Move to source window
W = Watch...
R = Replicate window
P = Properties...

� Status Window
R = Change program counter...
C = Change cycle counter...
T = Clear trace pointer
B = Break details...
P = Properties...

� Register Window
A = Change A...
C = Change C flag...
Z = Change Z flag...
G = Change G flag...
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H = Change H register...
L = Change L register...
N = Change HL index register...
X = Change X register...
Y = Change Y register...
I = Change XY index register...
M = Change MIE flag...
B = Change CBR...
E = Change EBR...
0 = Change RA0 register...
1 = Change RA1 register...
2 = Change RA2 register...
3 = Change RA3 register...
R = Change RA register...
S = Change SP...
P = Change RSP...

� SFR Window
C = Change...
F = Find...
W = Watch...
R = Replicate window

� Code Window
J = Jump...
C = Change...
F = Fill...
R = Replicate window
P = Properties...

� Data Window
J = Jump...
C = Change...
F = Fill...
O = Copy...
L = Load RAM data file...
S = Save RAM data to file...
R = Replicate window
P = Properties...

� External Data Window
J = Jump...
C = Change...
F = Fill...
O = Copy...
R = Replicate window
P = Properties...
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� Trace Window
J = Jump...
C = Clear trace memory
S = Search...
A = Save trace data...
R = Replicate window
P = Properties...

� Watch Window
I = Add item...
E = Delete item
A = Delete all
P = Item properties...
U = Up
D = Down
L = Load watch list...
S = Save watch list...
R = Replicate window

� Log Window
T = Cut
C = Copy
P = Paste
D = Delete
L = Select all
E = Clear log
S = Save log...

15.1.3  Tool Bar

    Open project

    Load program file

    Load RAM data file

    Execute program

    Reset and restart

    Step into

    Execute to cursor

    Reset system

    Reset CPU

DT63K
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    Reset options...

    Watch window

    Register window

    Status window

    Code window

    Data window

    External data window

    SFR window

    Cycle counter settings

    Trace options

    Options

    Macro

    Stop macro

    List symbols

    Help topics

15.1.4  Shortcut Keys
F1 Help
F2 Macro
F5 Execute program
F7 Execute to cursor
F8 Step into
F9 Toggle breakpoint
[Ctrl]+F2 Stop macro
[Ctrl]+F3 Clear IE bits
[Ctrl]+F5 Reset CPU
[Ctrl]+F6 Next window
[Ctrl]+[Shift]+F6 Previous window
[Ctrl]+[X] Cut
[Ctrl]+[C] Copy
[Ctrl]+[V] Paste
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15.1.5  Macro Commands

� Projects
PJLOD Load project
PJSAV Save project

� Display/Change CPU Internals
D Display register or SFR
C Change register or SFR
DPC Display program counter
CPC Change program counter
KILL Control TBC or WDT operation

� Code Memory
DCM Display code memory
CCM Change code memory
MCM Copy code memory
LOD Load program file
SAV Save program file
VER Compare code memory to program file
ASM Assemble string
STARTASM Start assembling block
ENDASM End assembly language block
DASM Disassemble
EXPAND Expand code memory

� Data Memory
DDM Display data memory
CDM Change data memory
MDM Copy data memory
DLOD Load RAM data file
DSAV Save RAM data file

� External Data Memory
DXM Display external data memory
CXM Change external data memory
MXM Copy external data memory
EXLOD Load external data memory file
EXSAV Save external data memory file

� Emulation
G Execute program
STP Step into

� Resets
RST Reset system
RST E Reset CPU
SRC Select reset source

DT63K
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URST Configure user cable RESET pin

� Emulation Breaks
SBC Specify break conditions
DBP Display breakpoints
SBP Set breakpoints
RBP Release breakpoints
DBS Display break status

� Tracing
DTM Display trace memory
STT Specify trace triggers
STC Specify trace conditions
DTR Display trace point list
STR Set trace point
RTR Release trace point
DTP Display trace pointer
RTP Reset trace pointer to zero
TRSAV Save trace memory contents to disk file
S Search trace memory

� Performance and Coverage
DCC Display cycle counter contents
CCC Change cycle counter contents
SCC Specify cycle counter count conditions
SCLK Specify high-speed clock frequency
CSTAT Specify cycle counter display mode
SCT Specify cycle counter triggers
DSO Display sync out point list
SSO Set sync out point
RSO Release sync out point
DIE Display IE bits
RIE Reset IE bits

� EPROM
TPR Load program from EPROM
VPR Compare program to EPROM

� Macros
PAUSE Pause macro execution
ECHO Send specified string to log
GOTO Branch to label
IF Conditional branch

� Symbols
DSYM Display symbol value
CSYM Change symbol value
RSYM Release symbol
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SSYM Set symbol

� Miscellaneous
VERSION Display DT63K version number
EXIT Exit debugger
SAVELOG Save macro results to disk file
CLRLOG Clear Log window
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15.2  DTS63K Simulator

15.2.1  Menus

� File (F)
O = Open project...
S = Save project
A = Save project as...
L = Load program file...
V = Save program to file...
C = Compare program and file...
D = Load external memory data file...
E = Save external memory data to file...
R = Load RAM data file...
M = Save RAM data to file...
G = Load LCD graphics...
P = Load port assignment file...
I = Save port assignments to file
T = Save port assignments as...
B = Load breakpoint file...
K = Save breakpoints to file...
X = Exit

� Edit (E)
T = Cut
C = Copy
P = Paste
D = Delete
L = Select all
F = Find...
E = Replace...

� View (V)
S = Source
A = Disassembly
U = Status
R = Registers
F = SFRs
C = Code
D = Data
X = External data
E = Trace memory
W = Watch list
G = Log

DTS63K
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L = LCD
P = Port
T = Tool bar
B = Status bar

� Run (R)
R = Reset simulator
O = Reset options...
X = Stop execution
M = Stop melody
E = Execute program
G = Execute to cursor
T = Reset and restart
S = Step into
O = Step over
C = Change program counter...
B = Toggle breakpoint
K = List breakpoints...
A = Clear all breakpoints
D = Break conditions...
I = Clear IE bits

� CycleCounter (C)
C = Clear
H = Change...
S = Settings...

� Trace (T)
C = Clear trace memory
T = Save trace data
S = Settings...

� Tools (L)
M = Macro
P = Stop macro
S = List symbols...
L = LCDTOOL
O = Options...
D = Environment settings

� Window (W)
O = Close active window
A = Close all
R = Replicate window
C = Cascade
V = Tile vertically
H = Tile horizontally
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� Help (H)
F = Find help on topic
A = About

15.2.2  Context Menus

� Source Window
G = Execute to cursor
B = Toggle breakpoint
K = List breakpoints...
L = Jump to line...
A = Jump to address...
U = Jump to PC line
D = Disassemble
W = Watch...
M = Move to file...
R = Replicate window
P = Properties...

� Disassembly Window
G = Execute to cursor
B = Toggle breakpoint
K = List breakpoints...
I = Clear IE bits
C = Change program counter...
L = Assemble...
A = Jump to address...
U = Jump to PC line
M = Move to source window
W = Watch...
R = Replicate window
P = Properties...

� Status Window
R = Change program counter...
C = Change cycle counter...
T = Clear trace pointer
B = Break details...
P = Properties...

� Register Window
A = Change A...
C = Change C flag...
Z = Change Z flag...
G = Change G flag...
H = Change H register...
L = Change L register...

DTS63K
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N = Change HL index register...
X = Change X register...
Y = Change Y register...
I = Change XY index register...
M = Change MIE flag...
B = Change CBR...
E = Change EBR...
0 = Change RA0 register...
1 = Change RA1 register...
2 = Change RA2 register...
3 = Change RA3 register...
R = Change RA register...
S = Change SP...
P = Change RSP...

� SFR Window
C = Change...
F = Find...
W = Watch...
R = Replicate window

� Code Window
J = Jump...
C = Change...
F = Fill...
R = Replicate window
P = Properties...

� Data Window
J = Jump...
C = Change...
F = Fill...
O = Copy...
R = Replicate window
P = Properties...

� External Data Window
J = Jump...
C = Change...
F = Fill...
O = Copy...
R = Replicate window
P = Properties...

� Trace Window
J = Jump...
C = Clear trace memory
S = Search...
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R = Replicate window
P = Properties...

� Watch Window
I = Add item...
E = Delete item
A = Delete all
P = Item properties...
U = Up
D = Down
L = Load watch list...
S = Save watch list...
R = Replicate window

� Log Window
T = Cut
C = Copy
P = Paste
D = Delete
L = Select all
E = Clear log
S = Save log...

� LCD Window
G = Load LCD data file...
L = LCDTOOL

� Port Window (Port or Key Map)
C = Change key assignments...
L = Load port assignment file...
S = Save port assignments to file
A = Save port assignments as...
R = Replicate window

� Port Window (Matrix)
I = Add input port...
O = Add output port...
D = Delete port
L = Load port assignment file...
S = Save port assignments to file
A = Save port assignments as...
R = Replicate window

15.2.3  Tool Bar

    Open project

    Load program file

DTS63K
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    Load LCD data file

    Load port assignment file

    Load RAM data file

    Execute program

    Reset and restart

    Step into

    Step over

    Execute to cursor

    Stop execution

    Reset simulator

    Reset options...

    Watch window

    Register window

    Status window

    Code window

    Data window

    External data window

    SFR window

    List symbols

    Options

    LCDTOOL

    Macro

    Stop macro

    Help topics



15.2 DTS63K Simulator

99

15.2.4  Shortcut Keys
F1 Help
F2 Macro
F5 Execute program
F7 Execute to cursor
F8 Step into
F9 Toggle breakpoint
[Ctrl]+F2 Stop macro
[Ctrl]+F3 Clear IE bits
[Ctrl]+F5 Reset CPU
[Ctrl]+F6 Next window
[Ctrl]+F8 Step over
[Ctrl]+[Shift]+F6 Previous window
[Ctrl]+[X] Cut
[Ctrl]+[C] Copy
[Ctrl]+[V] Paste
[ESC] Stop program

15.2.5  Macro Commands

� Projects
PJLOD Load project
PJSAV Save project

� Display/Change CPU Internals
D Display register or SFR
C Change register or SFR
DPC Display program counter
CPC Change program counter
MELODY Enable/disable melody function

� Code Memory
DCM Display code memory
CCM Change code memory
MCM Copy code memory
LOD Load program file
SAV Save program file
VER Compare code memory to program file
ASM Assemble string
STARTASM Start assembling block
ENDASM End assembly language block
DASM Disassemble
EXPAND Expand code memory

� Data Memory
DDM Display data memory
CDM Change data memory

DTS63K
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MDM Copy data memory
DLOD Load RAM data file
DSAV Save RAM data file

� External Data Memory
DXM Display external data memory
CXM Change external data memory
MXM Copy external data memory
EXLOD Load external data memory file
EXSAV Save external data memory file

� Simulation
G Execute program
STP Step into
STPO Step over

� Resets
RST Reset simulator
SRC Select reset source

� Simulation Breaks
SBC Specify break conditions
DBP Display breakpoints
SBP Set breakpoints
RBP Release breakpoints
DBS Display break status
BLOD Load breakpoint file
BSAV Save breakpoint file

� Tracing
DTM Display trace memory
STC Specify trace conditions
DTP Display trace pointer
RTP Reset trace pointer to zero
TRSAV Save trace memory contents to disk file
S Search trace memory

� Performance and Coverage
DCC Display cycle counter contents
CCC Change cycle counter contents
SCC Specify cycle counter count conditions
SCLK Specify high-speed clock frequency
CSTAT Specify cycle counter display mode
DIE Display IE bits
RIE Reset IE bits
WAIT Specify wait between instructions

� Macros
PAUSE Pause macro execution
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ECHO Send specified string to log
GOTO Branch to label
IF Conditional branch

� Symbols
DSYM Display symbol value
CSYM Change symbol value
RSYM Release symbol
SSYM Set symbol

� Miscellaneous
LLOD Load LCD data file
PLOD Load port assignment file
PSAV Save port assignment file
VERSION Display DTS63K version number
EXIT Exit simulator
SAVELOG Save macro results to disk file
CLRLOG Clear Log window
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15.3  LCDTOOL Utility

15.3.1  Menus

� File (F)
N = New
O = Open...
S = Save
A = Save as...
E = Export...
X = Exit

� Edit (E)
U = Undo
T = Cut
C = Copy
P = Paste
D = Delete
A = Cancel assignment
G = Group
R = Release group

� View (V)
Z = Zoom...
T = Tool bar
S = Status bar
A = Segment assignment tool
C = Force display tool

� Tools (T)
D = Dot matrix...
S = Settings...
C = Common/segment numbers

� Help (H)
H = Help topics...
A = About

15.3.2  Context Menu
T = Cut
C = Copy
P = Paste
D = Delete
A = Cancel assignment

LCDTOOL

LCDTOOL
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G = Group
R = Ungroup

15.3.3  Tool Bar

    New

    Open...

    Save

    Cut

    Copy

    Paste

    Display/hide segment assignment tool

    Display/hide force display tool

  Zoom...

    Help

15.3.4  Shortcut Keys
[Ctrl]+[N] New
[Ctrl]+[O] Open...
[Ctrl]+[S] Save
[Ctrl]+[Z] Undo
[Ctrl]+[X] Cut
[Ctrl]+[C] Copy
[Ctrl]+[V] Paste
[Del] Delete

LCDTOOL
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15.4  Script Command Reference

15.4.1  Projects
� Load Project

PJLOD  filename

filename:  Name of project file to load

� Save Project

PJSAV  filename

filename:  Name for project file

15.4.2  Display/Change CPU Internals
� Display Register or SFR

D  parm

parm:  Reg_name or SFR_name from C command

� Change Register or SFR

C  Reg_name = data

Reg_name: ACC Accumulator
C Carry (C) flag
Z Zero (Z) flag
G G flag
H H register
L L register
HL HL register (byte)
X X register
Y Y register
XY XY register (byte)
CBR Current bank register
EBR Extra bank register
RA0–RA3 RA register
RA RA3–RA0 (RA registers (word))
RSP Register stack pointer

data:  New contents
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� Change SFR

C  Sfr_name = data

Sfr_name:Name of register assigned to SFR region

data:  New contents

� Display Program Counter

DPC

� Change Program Counter

CPC  address

address:  New code address for program counter

� Enable/Disable Melody Function

MELODY

MELODY  parm

parm: ON Enable melody function
OFF Disable melody function

� Control TBC or WDT Operation

KILL

KILL  parm

parm: TBC Enable time base counter
WDT Enable watchdog timer
* Enable both time base counter and watchdog timer
~TBC Disable time base counter
~WDT Disable watchdog timer
~* Disable both time base counter and watchdog timer

15.4.3  Code Memory
� Display Code Memory

DCM  address

address: Code address to display

DCM  [start-address end-address]

start-address: First code address to display
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end-address: Last code address to display

� Change Code Memory

CCM  address = data

address: Code address to modify

data: New contents

CCM  [start-address end-address] = data

start-address: First code address to modify

end-address: Last code address to modify

data: New contents

� Copy Code Memory

MCM  [start-address end-address] trans-address

start-address: First code address to copy

end-address: Last code address to copy

trans-address: Destination code address

� Load Program File

LOD  filename  { option ... option}

filename: Name of program file to load

option: /NS Skip symbol table
       /B Clear all breakpoints

� Save Program File

SAV  filename{[ start-address end-address]}{ option ... option}

filename: Name for program file

start-address: First code address to save

end-address: Last code address to save

option: /NS Skip symbol table

� Compare Code Memory to Program File

VER  filename
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VER  filename [start-address end-address]

filename: Name of program file to compare

start-address: First code address to compare

end-address: Last code address to compare

� Assemble String

ASM  address “assemble-string”

ASM  “assemble-string”

address: Code memory address

“assemble-string” Assembly language instruction to assemble

Note: The second form is for use inside a block starting with STARTASM and
ending with ENDASM.

� Start Assembling Block

STARTASM  address

address: Code memory address

� End Assembly Language Block

ENDASM

� Disassemble

DASM  address { option ... option}

DASM  [start-address end-address]{ option ... option}

address: Code memory address

start-address: First code address to disassemble

end-address: Last code address to disassemble

option: /NC Skip instruction codes
       /NL Skip addresses

� Expand Code Memory

EXPAND

EXPAND  parm
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parm: ON Enable code memory expansion
    OFF Disable code memory expansion

15.4.4  Data Memory
� Display Data Memory

DDM  address

DDM  [start-address end-address]

address: Data address to display

start-address: First data address to display

end-address: Last data address to display

� Change Data Memory

CDM  address = data

CDM  [start-address end-address] = data

address: Data address to modify

start-address: First data address to modify

end-address: Last data address to modify

data: New contents

� Copy Data Memory

MDM  [start-address end-address] trans-address

start-address: First data address to copy

end-address: Last data address to copy

trans-address: Destination data address

� Load RAM Data File

DLOD  filename

filename: Name of RAM data file to load

� Save RAM Data File

DSAV  filename{[ start-address end-address]}

DT63K
DTS63K

DT63K
DTS63K

DT63K
DTS63K

DT63K
DTS63K

DT63K
DTS63K



15.4 Script Command Reference

109

filename: Name for RAM data file

start-address: First data address to save

end-address: Last data address to save

Note: Addresses in SFR area cannot be specified for start- and end-addresses.

15.4.5  External Data Memory
� Display Current Bank in External Data Memory

DXM  address

DXM  [start-address end-address]

address: External data address to display

start-address: First external data address to display

end-address: Last external data address to display

� Change Current Bank in External Data Memory

CXM  address = external_data

CXM  [start-address end-address] = external_data

address: External data address to modify

start-address: First external data address to modify

end-address: Last external data address to modify

external_data: New contents

� Copy External Data Memory

MXM  [ start-address end-address] trans-address

start-address: First external data address to copy

end-address: Last external data address to copy

trans-address: Destination external data address

� Load External Data File

EXLOD  filename

filename: Name of external data file to load

� Save External Data File
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EXSAV  filename

EXSAV  filename [start-address end-address]

filename: Name for external data file

start-address: First external data address to save

end-address: Last external data address to save

15.4.6  Execution
� Execute from Current PC Position without Breakpoint

G

� Execute from Specified Address without Breakpoint

G  address

address: Starting code memory address

� Execute with Single Breakpoint

G {address} , break-address

address: Starting code memory address

break-address: Breakpoint address

� Execute with Address Pass Count Break

G {address} , break-address [count]

address: Starting code memory address

break-address: Breakpoint address

count: Number of matches before break

� Execute with RAM Data Match Break

G {address} , RAM {ram-address}{AND mask_data} =
data{[count]}{break_address}

address: Starting code memory address

ram-address: RAM address to monitor

mask_data: Mask for comparison
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data: Data for comparison

count: Number of matches before break

break_address: address Single address

[start-addres end-address] Address range

� Execute with RAM Address Access Break

G {address} , RADR {AND mask_data} = ram-address {[ count]}

address: Starting code memory address

mask_data: Mask for comparison

ram-address: RAM address to monitor

count: Number of matches before break

� Execute with Internal ROM Table Data Match Break

G {address} , TBL {tbl-address}{AND mask_data} = data {break_address}

address: Starting code memory address

tbl-address: Internal ROM table address to monitor

mask_data: Mask for comparison

data: Data for comparison

break_address: address Single address
[start-addres end-address] Address range

� Execute with Internal ROM Table Address Access Break

G {address} , TADR {AND mask_data} = tbl-address

address: Starting code memory address

mask_data: Mask for comparison

tbl-address: Internal ROM table address to monitor

� Execute with External Data Memory Data Match Break

G {address} , EXM access {ext-address}{AND mask_data} =
data{break_address}

address: Starting code memory address

access: R Read

W Write
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RW Read or write

ext-address: External data memory address to monitor

mask_data: Mask for comparison

data: Data for comparison

break_address: address Single address
[start-addres end-address] Address range

� Execute with External Data Memory Address Access Break

G {address} , EADR {AND mask_data} = ext-address

address: Starting code memory address

mask_data: Mask for comparison

ext-address: External data memory address to monitor

� Step Into

STP {address}{ , count}

address: Starting code memory address

count: Number of steps to execute

� Step Over

STPO {address}{ , count}

address: Starting code memory address

count: Number of steps to execute

15.4.7  Resets
� Reset Emulator or Simulator

RST

� Reset CPU

RST E

� Select Reset Option

SRC
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SRC  parm Enable reset option

SRC  ~parm Disable reset option

parm: CC Cycle counter
    IE All IE bits

    TP Trace pointer

� Configure User Cable RESET Pin

URST

URST  parm

parm: ON Enable user cable RESET input
OFF Disable user cable RESET input

15.4.8  Breaks
� Specify Break Conditions

SBC

SBC  parm Enable break condition

SBC  ~parm Disable break condition

parm: BP Breakpoint break
CC Cycle counter overflow break
TF Trace full break
XP External break
PD Power down break
PC Call stack overflow break
RG Register stack overflow break
* All

� Specify Break Conditions

SBC

SBC  parm Enable break condition

SBC  ~parm Disable break condition

parm: BP Breakpoint break
CC Cycle counter overflow break
TF Trace full break
PC Call stack overflow break
RG Register stack overflow break
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� Display Breakpoints

DBP

� Set Breakpoint

SBP  address

address: Code memory address

� Release Breakpoints

RBP  bp-address

bp-address: address Breakpoint address
* All addresses

� Display Break Status

DBS

� Load Breakpoint File

BLOD  filename

filename: Name of breakpoint data file to load

� Save Breakpoint File

BSAV  filename

filename: Name for breakpoint data file

15.4.9  Tracing
� Display Trace Memory

DTM  TP_number steps

TP_number: Starting entry number

steps: Number of entries to display

� Display Trace Memory Relative to Current Position

DTM  BACK steps1 steps2
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steps1: Number of entries to scroll back from current trace pointer position

steps2: Number of entries to display from that entry

� Specify Trace Triggers

STT

STT  parm

parm: ALL Free running

DIS Disable tracing

STT  SS  {parm}{, parm}

parm: address Single address
[start-address end-address] Address range
. (period) Start or end of execution

� Specify Trace Conditions

STC

STC  TR Enable tracing

STC  ~TR Disable tracing

� Display Trace Point List

DTR

� Set Trace Point

STR  address Single address

STR  [start-address end-address] Address range

� Release Trace Point

RTR  tp-address

tp-address: address Single address
[start-address end-address] Address range
* All addresses

� Display Trace Pointer

DTP
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� Reset Trace Pointer to Zero

RTP

� Save Trace Memory Contents to Disk File

TRSAV  filename

TRSAV  filename [start-TP end-TP]

filename: Name for trace data file

start-TP: First trace entry to save

end-TP: Last trace entry to save

� Search Trace Memory

S  col {AND mask_data} = data{[ count]} Search forward

S  ~col {AND mask_data} = data{[ count]} Search backward

col: ADRS Instruction address
          ACC Accumulator
          RADR RAM address
          RD RAM data
          C Carry (C) flag
          Z Zero (Z) flag
          G G flag
          MI Master interrupt enable (MIE) flag
          MD Melody request flag
          CB Current bank register
          EB Extra bank register
          HL HL register (byte)
          XY XY register (byte)
          SP Stack pointer

          RS Register stack pointer

mask_data: Mask for comparison

data: Data for comparison

count: Number of matches before break

15.4.10  Performance and Coverage
� Display Cycle Counter Contents

DCC
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� Change Cycle Counter Contents

CCC  data

data: New contents

� Specify Cycle Counter Count Conditions

SCC

SCC  CC {option} Enable counting

SCC  ~CC Disable counting

option: /NS     Skip symbol table

� Specify Cycle Counter Triggers

SCT  parm

parm: ALL Free running

DIS Disable counting

SCT  SS  {parm}{, parm}

parm: address Single address
[start-address end-address] Address range
. (period) Start or end of execution

� Specify High-Speed Clock Frequency

SCLK

SCLK  value  unit

value: Decimal value

unit: Hz, kHz, or MHz

� Specify Cycle Counter Display Mode

CSTAT  mode

mode: CC Count
TM Time

� Display Sync Out Point List

DSO
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� Set Sync Out Point

SSO  address Single address

� Release Sync Out Point

RSO  so-address

so-address: address Single address
* All addresses

� Display IE Bits

DIE  ie-address

ie-address: address Single address
[start-addres end-addres] Address range

� Reset IE Bits

RIE

� Specify Wait Between Instructions

WAIT

WAIT   parm

parm: Decimal value (ms)

15.4.11  EPROM
� Load Program from EPROM

TPR  [start-address end-address]  cm-address

start-address: First EPROM address to copy

end-address: Last EPROM address to copy

cm-address: Destination code memory address

� Compare Program to EPROM

VPR  [start-address end-address] eprom-address

start-address: First EPROM address to compare
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end-address: Last EPROM address to compare

eprom-address: Destination EPROM address

15.4.12  Macros
� Pause Macro Execution

PAUSE

� Send Specified String to Log

ECHO statement

statement: statement  parm

parm: Text in double quotes
$TIME Current time
$DATE Current date

� Branch to Label

GOTO  label

:label Label for destination

� Conditional Branch

IF  compare  statement

compare: value-comp
lastline-comp

value-comp: obj  cond  value

obj: ACC, C, Z, G, CBR, EBR, MIE, RSP, SP, HL, XY, RA
PC, SFR name, data-address

cond: == or !=

value: Expression

data-address: Expression evaluating to a data address

lastline-comp: LASTLINE cond “string”

Compare to last line

LASTLINE(n) cond “string”

Compare to line n lines back

statement: THEN  command
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GOTO  label

command: Script command

� Save Macro Results to Disk File

SAVELOG  filename

filename: Name for log file

� Clear Log window

CLRLOG

15.4.13  Symbols
� Display Symbol Value

DSYM  symbol

symbol: Symbol name (or mask containing wild cards)

� Change Symbol Value

CSYM  symbol = data

symbol: Symbol name

data: New contents

� Release Symbol

RSYM  symbol

symbol: Name or user-defined symbol (or mask containing wild
cards)

� Set Symbol

SSYM  symbol = data { attribute}

symbol: Symbol name
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data: Contents

attribute: Symbol attribute
     /C Code
     /D Data
     /X External data
     /B Bit data

     /N Numerical value

15.4.14  Miscellaneous
� Load LCD Data File

LLOD  filename

filename: Name of LCD data file to load

� Load Port Assignment File

PLOD  filename

filename: Name of port assignment file to load

� Save Port Assignment File

PSAV  filename

filename: Name for port assignment file

� Display Version Number

VERSION

� Exit Debugger

EXIT
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Index
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100Hz Timer/Counter .....................................69

3

32-bit applications.............................................1

A

A ....................................................................49

Accumulator....................................................41

Address Pass Count(DT63K)..........................33

Address Pass Count(DTS63K)........................38

Arithmetic Operators.......................................62

ASCII format.....................................................8

ASM Command.............................................107

Assigning Ports ...............................................15

B

Backing Up the Software ................................10

Backup Circuit ................................................72

Batch processing ...............................................2

Battery Low Detector ......................................72

Binary format ....................................................8

Bitmap

Copying ......................................................81

Deleting ......................................................81

Grouping.....................................................81

Moving........................................................81

Undoing ......................................................81

Bit-mapped file ...............................................15

BLOD Command ..........................................114

Break Condition Check Boxes(DT63K) .........32

Break Condition Check Boxes(DTS63K) .......37

Break Conditions(DT63K)..............................31

Break Conditions(DTS63K)............................37

Break Parameters(DT63K) .............................33

Break Parameters(DTS63K) ...........................38

Breakpoint(DT63K)........................................32

Breakpoint(DTS63K)......................................37

Breakpoints .....................................................29

BSAV Command...........................................114

Buzzer ...............................................................3

Buzzer Driver ..................................................71

Byte ...................................................................5

C

C Command...................................................104

Call Stack Overflow(DT63K) .........................32

Call Stack Overflow(DTS63K) .......................37

Carry Flag........................................................41

CB ...................................................................49

CCC Command .............................................117

CCM Command ............................................106

CDM Command ............................................108

CGZ.................................................................49

Change key assignments..................................70

Character Constants.........................................61

Clearing Breakpoints.......................................22

Clock operating frequencies..............................6

CLRLOG Command .....................................120

Code Memory..................................................43

Code Memory Assembler................................44

Code Memory Expansion..........................14, 20

COM................................................................77

Common..........................................................76

Comparing Code Memory to File....................24

Comparing Code to EPROM...........................66

Comparing Complete Program........................24

Constants .........................................................61

Context Menu(LCDTOOL)...........................102

Context Menus(DT63K) .................................86

Context Menus(DTS63K) ...............................95

Continuous Execution .....................................26

Control Panels .................................................10

CPC Command..............................................105

CPU Reset .......................................................28

CSTAT Command.........................................117

CSYM Command..........................................120

Current Bank Register .....................................41

Cursor..............................................................31

CXM Command ............................................109

Cycle counter.....................................................2

Cycle Counter..................................................54

Changing.....................................................54
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Displaying ..................................................54

Options .......................................................55

Overview ....................................................54

Cycle Counter Overflow .................................54

Cycle counter overflow(DT63K) ....................32

Cycle counter overflow(DTS63K)..................37

Cycle Counter(DT63K) ..................................54

Cycle Counter(DTS63K) ................................54

D

D Command..................................................104

D63 .................................................................25

DASM Command .........................................107

Data Memory ..................................................43

DBP Command.............................................114

DBS Command .............................................114

DCC Command.............................................116

DCM Command............................................105

DDM Command............................................108

Development language......................................6

Development process........................................8

DIE Command ..............................................118

Directories settings .........................................13

Display..............................................................6

Displaying Key Assignments ..........................17

Displaying Key Matrix....................................16

Displaying Port Assignments ..........................15

DLOD Command..........................................108

Dot matrix.......................................................75

Dot Operator ...................................................62

DPC Command .............................................105

DSAV Command ..........................................108

DSO Command.............................................117

DSPR ........................................................26, 77

DSYM Command .........................................120

DT63K Debugger Features...............................2

DT63K Project File ........................................25

DTM Command............................................114

DTP Command .............................................115

DTR Command.............................................115

DTS63K Project File ......................................25

DTS63K Simulator Features.............................2

Dumping Memory...........................................43

DXM Command............................................109

E

E ....................................................................50

EB ...................................................................49

ECHO Command ..........................................119

ENDASM Command ....................................107

Environment Settings ......................................13

EPROM...........................................................66

EXIT Command............................................121

EXLOD Command........................................109

EXPAND Command.....................................107

Expressions .....................................................60

EXSAV Command........................................110

External Data File .............................................9

External Data Memory..............................20, 71

External Memory ............................................43

External Memory Address Access(DT63K) ...36

External Memory Data Match(DT63K)..........35

External(DT63K) ............................................32

Extra Bank Register ........................................41

F

Filling Memory ...............................................44

Floppy disk drive ..............................................6

Forced Break...................................................31

G

G Command ..................................................110

G Flag .............................................................41

GOTO Command..........................................119

H

Hard disk space.................................................6

High-Speed Clock...........................................20

HL...................................................................50

HL Register.....................................................41

I

I ....................................................................50

I/O port simulation..........................................15

IE Bits .............................................................27

IF Command .................................................119

In-circuit emulator.............................................6
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Input Formats ..................................................59

Installing..........................................................10

Instruction Set .................................................68

Integer Constants.............................................61

Intel HEX format...............................................8

Intel HEX Half-Word Files...............................8

Internal ROM Table Address Access(DT63K)35

Internal ROM Table Data Match(DT63K)......34

J

Jumping to an Address ....................................44

K

Key matrix.......................................................70

Keymap button................................................17

KILL Command ............................................105

L

LCD Data File...................................................9

Saving .........................................................79

LCD Data Files

Editing ........................................................81

LCD Driver .....................................................71

LCD panel simulation .......................................2

LCD pixels ......................................................21

LCD Refresh Period Setting............................20

LCD Screen Refresh Period ............................73

LCD Settings...................................................21

LCD window...................................................73

LCDTOOL......................................................73

Assigning by DSPR Value..........................78

Assigning Common and Segment Outputs..78

Assigning Common Outputs .......................77

Assigning Segment Outputs........................78

Canceling Assignments...............................81

Creating .BMP File.....................................74

Creating Dot Matrix....................................75

Displaying Assignments..............................79

Loading .BMP Data....................................75

Making Assignments...................................77

On-Line Help ..............................................83

Overview.....................................................74

Procedure....................................................74

LCDTOOL utility............................................15

LCDTOOL Utility...........................................74

Limiting the Range....................................23, 24

Listing Breakpoints .........................................30

LLOD Command...........................................121

Loading Code from EPROM...........................66

Loading Debugging Information .....................22

Loading DT63K Debugger..............................11

Loading DTS63K Simulator ...........................12

Loading LCD Data File...................................15

Loading Only Program Code...........................22

Loading Program Code ...................................22

LOC.................................................................49

LOD Command .............................................106

Log Window....................................................64

M

Macro

Breaks .......................................................113

Code Memory ...........................................105

Data Memory ............................................108

Display/Change CPU Internals .................104

Execution ..................................................110

External Data Memory..............................109

Macros ......................................................119

Miscellaneous ...........................................121

Performance and Coverage .......................116

Projects .....................................................104

Resets........................................................112

Script Command Reference ......................104

Tracing......................................................114

Macro Commands(DT63K) ............................90

Macro Commands(DTS63K) ..........................99

Macro functions.................................................2

Macros.............................................................63

Master Interrupt Enable Flag...........................41

Matrix button...................................................16

MCM Command............................................106

MD ..................................................................49

MDM Command ...........................................108

MELODY Command ....................................105

Melody Driver.................................................71

Melody Output ................................................20
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Melody simulation ............................................3

Memory Spaces...............................................68

Menus(DT63K)...............................................84

Menus(DTS63K) ............................................93

Menus(LCDTOOL) ......................................102

MI ...................................................................49

Mouse ...............................................................6

Multi window interface.....................................1

Multiplier/Divider Circuit ...............................72

MXM Command...........................................109

N

New button......................................................19

Nibble ...............................................................5

None(DT63K).................................................33

None(DTS63K) ..............................................38

Notational Conventions ....................................5

nX-4/250 core .................................................69

O

OLMS-63K series .............................................1

On-Line Help ..................................................64

Contents......................................................64

keywords ....................................................65

On-screen help ..................................................1

Operating environment .....................................6

Operating Frequency.......................................67

Operating System..............................................6

Operators ........................................................62

P

PAUSE Command ........................................119

PC ...................................................................49

PJLOD Command.........................................104

PJSAV Command .........................................104

PLOD Command ..........................................121

Port button ......................................................15

Port simulation..................................................2

Port window....................................................15

Ports................................................................70

Power Down(DT63K).....................................32

Preparing for Debugging.................................13

Preparing for Emulation..................................13

Preparing for Simulation.................................15

Probe cable........................................................7

Program Counter.............................................40

Program Execution..........................................26

Project File......................................................25

Project settings................................................13

PSAV Command...........................................121

Q

Quick on-screen help ........................................1

R

RA Registers ...................................................41

RADR .............................................................49

RAM Address Access(DT63K) ......................34

RAM Address Access(DTS63K) ....................39

RAM Data Match(DT63K).............................33

RAM Data Match(DTS63K)...........................38

RBP Command .............................................114

RD...................................................................49

Real-time emulation ..........................................2

Register Set .....................................................68

Register Stack Overflow(DT63K) ..................32

Register Stack Overflow(DTS63K) ................37

Register Stack Pointer.....................................42

Register window..............................................40

Registers..........................................................40

Resets..............................................................28

RIE Command...............................................118

RS ...................................................................50

RSO Command .............................................118

RST Command..............................................112

RST E Command ..........................................112

RSYM Command..........................................120

RTP Command..............................................116

RTR Command .............................................115

S

S Command...................................................116

S63 ..................................................................25

SASM63K structured assembler ...................1, 8

SAV Command .............................................106

SAVELOG Command...................................120
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Saving Program Code .....................................23

Saving Program Code Only.............................23

Saving Symbol Table ......................................23

SBC Command..............................................113

SBP Command..............................................114

SCC Command..............................................117

SCLK Command...........................................117

Scripting language.............................................2

SCT Command..............................................117

SEG.................................................................77

Segment...........................................................76

Serial port..........................................................6

Serial Ports......................................................71

Setting Breakpoints .........................................29

Setting Up a Key Matrix .................................18

SFR .................................................................42

Adding to Watch List..................................42

Searching ....................................................42

SFR window....................................................42

Shift Registers .................................................71

Shortcut Keys(DT63K) ...................................89

Shortcut Keys(DTS63K).................................99

Shortcut Keys(LCDTOOL)...........................103

Simulation

Instruction Execution..................................67

Interrupt ......................................................72

LCD ............................................................72

Onboard Peripherals ...................................69

Reset ...........................................................68

Simulator Reset ...............................................28

Single-step execution ........................................2

Single-Step Execution.....................................26

Source .............................................................50

Source Files
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Switching ....................................................57
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Source Level Debugging.................................57
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Executing to Cursor ....................................58

Switching from Trace Window...................58

Switching to Disassembly Window.............58
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Specifying Reset Scope ...................................28
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Specifying Target Device................................13
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